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Abstract 

Interaction Supervisor is a client-side application that Contact Center Supervisors use to view 
statistics and to be alerted when statistics reach predetermined performance levels.  This 
publication explains how to use Interaction Supervisor to monitor the activity of agents, 
workgroups, telephony hardware, and other objects in real-time.  
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Introduction 
Interaction Supervisor is a tool for monitoring Interaction Center agents, workgroups, queues, lines, 
and stations.  It is the IC's real-time performance monitoring system.  This client-side application 
displays workgroup and queue statistics, and sends notifications when statistics reach predetermined 
performance levels.  Contact Center Supervisors use Interaction Supervisor to view graphs and tables 
that consolidate statistics from multiple workgroups.   

Although the Interaction Client provides limited user, workgroup and queue monitoring capabilities, 
Interaction Supervisor is more powerful and summarizes additional operational statistics.  It allows a 
user to: 

 Monitor single workgroups 
 Monitor multiple workgroups 
 Set alerts to inform of events triggered by statistical changes 
 View real-time statistics in graphs and consolidated tables 

Audience 
Interaction Supervisor is designed to satisfy the advanced monitoring requirements of supervisors, 
managers, and executives who need to quickly examine real-time operational information across 
their contact centers.  General familiarity with Microsoft Windows and with the IC platform is 
assumed.  This publication explains how to set alerts and view real-time statistics and graphs in 
Interaction Supervisor.  It provides general help for working with the application.  Other help 
modules explain the features of plug-in extensions (p. 10). 

Organization of Material 
This publication is organized into sections that should be read in order.  However, the material is 
hyperlinked to allow non-linear navigation. 

1. This introduction describes the program, its documentation and copyrights. 

2. The Overview (p. 7)  explains what Interaction Supervisor can do for you. 

3. Procedures (p. 18)  explain how to install and start Supervisor, manage views, graphs, alerts, 
toolbars, and other features of the program.  

4. The User Interface (p. 82)  section covers dialogs and configurable options in the program.    

5. The Glossary (p. 132)  explains special terms used in this documentation. 

6. The Change Log (p. 135)  explains "what's new" in this release.  

The online help version of this document merges plug-in (p. 10)  module helps at runtime.  This 
adds additional help topics to the table of contents pane on the left side of the display. 
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Copyright and Trademark Information 
©1994 – 2005 Interactive Intelligence Inc./ Vonexus Inc. All rights reserved. Vonexus is a wholly-
owned subsidiary of Interactive Intelligence Inc. Interactive Intelligence®, Interaction Center 
Platform®, Communité®, Enterprise Interaction Center®, Interactive Intelligence Customer 
Interaction Center®, e-FAQ®, e-FAQ Knowledge Manager, Interaction Dialer®, Interaction 
Director®, Interaction Marquee, Interaction Recorder®, Interaction SIP Proxy, Interaction 
Supervisor, Interaction Tracker, Mobilité®, Vocalité®, Interaction Administrator®, Interaction 
Attendant®, Interaction Client®, Interaction Designer®, Interaction Fax Viewer, Interaction FAQ, 
Interaction Melder, Interaction Screen Recorder, Interaction Scripter®, Interaction Server, Wireless 
Interaction Client, InteractiveLease®, and the "Spirograph" logo design® are all trademarks or 
registered trademarks of Interactive Intelligence Inc.  

Other brand and/or product names referenced in this document are the trademarks or registered 
trademarks of their respective companies. 

Interactive Intelligence Inc.  
7601 Interactive Way 
Indianapolis, Indiana  46278 
Telephone/Fax (317) 872-3000 
www.ININ.com 

Vonexus  
7601 Interactive Way 
Indianapolis, Indiana  46278 
Telephone/Fax (888) 817-5904 
www.vonexus.com 

DISCLAIMER 

Interactive Intelligence (Interactive) has no responsibility under warranty, indemnification or 
otherwise, for modification or customization of any Interactive software by Interactive, Customer 
or any third party even if such customization and/or modification is done using Interactive tools, 
training or methods documented by Interactive. 

Interaction Center Platform Statement 
This document describes Interaction Center (IC) features that may not be available in your IC 
product. Several products are based on the IC platform, and some features are disabled in some 
products.  Several products are based on the IC platform:  

 Customer Interaction Center (CIC)  
 Enterprise Interaction Center (EIC)  
 Communité 

While all of these products share a common feature set, this document is intended for use with all 
IC products, and some of the described features may not be available in your product.  

How do I know if I have a documented feature? 

Here are some indications that the documented feature is not available in your version: 

 The menu, menu item, or button that accesses the feature appears grayed-out. 
 One or more options or fields in a dialog box appear grayed-out. 
 The feature is not selectable from a list of options. 

If you have questions about feature availability, contact your vendor regarding the feature set 
available in your version of this product. 

http://www.inin.com/
http://www.inin.com/
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Overview 
Interaction Supervisor is a standalone monitoring application for IC.  It satisfies the monitoring 
requirements of contact center supervisors, managers, and executives who need to view operational 
information across the contact center in real time. 

Think of Interaction Supervisor as a container application that displays views (p. 8)  of data.  
Supervisor itself does not acquire data.  Instead, plug-in (p. 10)  modules supply data and views to 
Supervisor so that it can graph, display, and alert on statistical data from various IC subsystems.  
Once you know how to use Supervisor's graphical user interface, you can quickly manage information 
provided by any plug-in module in the system. 

Supervisor consists of a main window with a title, menu, and one or more dockable toolbars.  The 
main window contains one workspace and any number of configurable views.   Each plug-in adds one 
or more views that display a general class of statistics.  You can customize a view to include or exclude 
data items, and set alerts that notify of events triggered by statistical changes.  Graphical views can 
be customized to meet personal monitoring requirements.  Since Supervisor is event-driven, its 
information is always up-to-date. 

Supervisor makes it easy to analyze statistics across reporting periods and data types.  Using the 
workgroup plug-in for example, you can compare, contrast, and consolidate information for agents and 
workgroups.  Likewise, an optional plug-in for Interaction Dialer reports agent activity across 
campaigns, workflows and sites.   

Interaction Supervisor is a standard IC component.   In its default configuration, it provides a System 
plug-in that monitors IC system performance and status.  The System plug-in is included at no charge, 
and does not require a license.  Additional plug-in modules may be licensed to monitor workgroups, 
Interaction Dialer, Interaction Director, etc.   

Related Topics 

 Views (p. 8)  

 Workspace (p. 9)  

 Plug-in Architecture (p. 10)  

 Software, hardware, and access right requirements (p. 12)  
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Views 
A view is a window that displays data.  Information can be displayed in columns, or rendered as a 
graph.  Views can be positioned anywhere on the screen, or docked within Supervisor's workspace.   

 

Each view can be displayed in one of three ways: 

 as a floating window that you can position anywhere on the screen. 

 as a docked window that is anchored to the top, left, bottom, or right edge of the workspace.    

 as a tab page.   

Supervisor displays any combination of floating, docked, or tabbed views at once.  It provides 
extensive control over the display and positioning of view windows. Individual views can be resized, 
scrolled, moved, docked, tabbed, or floated.  You can tile, cascade, and arrange window icons for 
all views at once.    

Window settings are stored so that users don’t have to customize the display each time Interaction 
Supervisor is restarted.  At startup, Interaction Supervisor reopens views in the mode and position 
used in the previous session. 

Practical Limitations 

Interaction Supervisor does not limit the number of items that a user can attempt to monitor. 
Consequently, it is possible to degrade its performance or lock the application by overwhelming it 
with items to monitor. For example, if all statistics for 300 workgroups are selected, Supervisor will 
lock up or perform slowly, since its overview views are designed to compare no more than a couple 
dozen agents/workgroups. In practical terms, you can avoid performance issues by limiting 
displays to approximately 25 workgroups at a time.  If performance lags, try selecting fewer items 
to monitor. 

Related Topics 

 Manage Views (p. 29)  
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Workspace 
When views are docked or displayed as tab pages, they appear within Supervisor's main window, 
which is called the workspace.   

 

 The workspace can be displayed full-screen (p. 51)  mode, so that toolbars, menus, and 
window borders do not appear.    

 Tabbed pages can be displayed in slide show (p. 52)  mode, which cycles between views 
every 5 seconds.  

Related Topics 

 Manage Views (p. 29)   
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Plug-in Architecture 
Interaction Supervisor is a container that docks, displays, and manages views of data.  Views are 
added by to Supervisor by plug-in modules (DLLs) that extend its monitoring capability in some 
way.  For example, the plug-in for Interaction Dialer (SupDialerA.dll) enhances Supervisor to 
display information about outbound campaigns and workflows. 

Plug-in modules extend functionality 
At startup, the Interaction Supervisor executable (SupervisorA.exe) looks in its own directory 
for extension DLLs, and attempts to load them.  It locates DLL filenames that begin with "Sup" 
which indicates that the file is a Supervisor plug-in.  The DLL may have an "A" or "AD" suffix to 
indicate its build type (A = ANSI Release, AD= ANSI Debug).  The ".DLL" file extension 
indicates that the file is a dynamic link library.   

View, menu, and toolbar integration 
Supervisor will accept any number of plug-ins.  A plug-in may define its own menus to merge 
into the main application menu, and may also export one or more toolbars.  When a plug-in is 
loaded, it describes itself to Supervisor in a standard way that facilitates seamless integration 
with the user interface.  Each plug-in passes Supervisor its name, the name of each view, a 
short description of each view, icons, preview images, and other elements that Supervisor 
needs to integrate its functionality. 

The dialog below demonstrates integration of three plug-in modules (Dialer, System, and 
Workgroups).  This dialog adds a new view to the workspace.  As you can see, the dialog 
displays a tab for each loaded plug-in, and offers icons and preview images for the selected 
view.   

 

Plug-ins also customize toolbars and menu options.  However, Supervisor provides standard 
commands that minimize the need to add extra GUI controls.  For example, its Add/Remove 
Statistics command changes the statistics displayed in a view.  When that command is invoked, 
the plug-in displays a custom dialog that lists choices that are appropriate for the view.  The 
functionality difference is seamless, and the command is the same for all plug-ins.  Menu and 
toolbar integration can be summarized as follows: 

 Supervisor supports additional menu and toolbar items as needed.  The functionality of 
built-in commands varies between views to accommodate different kinds of data.   

 Menus are merged dynamically and present appropriate commands for the active view. In 
general, a plug-in adds a single menu item for each of its views.  When the view is active, 
its menu appears in Supervisor's menu bar.  Plug-ins may also add items to built-in 
menus.  For example, a plug-in might add a command to the Edit menu.   

 Toolbars are completely separate from views.  A plug-in may define any number of 
toolbars, regardless of the number of views it contains.   



 

Interaction Supervisor User Guide Page 11 of 139 

Automatic software updates 
Once Interaction Supervisor is installed, new and updated plug-ins are automatically installed 
on client PCs by the IC's Auto-Updater subsystem.  Auto-Updater applies automatic updates to 
client PCs to add functionality and to apply hot fixes.  As a result, Interaction Supervisor is self-
updating once it is installed.   

 

To view and use plug-ins, access rights (p. 13)  must be assigned to your station. 

Supports a switchover environment 
Supervisor watches for Switchover notifications.  If you install Interaction Supervisor in a 
switchover environment, it will automatically restart and connect to a backup server if the 
primary IC server fails.  There is no need to manually restart Interaction Supervisor after a 
switchover.   Alerts switchover too, since the Alert server replicates all alerts to the backup 
server.  After a switchover, Users will continue to receive visual, audio and email Alerts. 
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Software, hardware and access right requirements 
This section specifies which Windows versions are supported, and recommended processor, RAM, 
and disk space requirements.  It also discussions rights that must be assigned to you in Interaction 
Administrator in order to use Interaction Supervisor to its full potential. 

Client workstations running IC and Interaction Supervisor require the following software and 
hardware components: 

Versions of Windows Supported 
 NT Workstation 4.0 
 NT Server 4.0 
 Windows 2000 Professional 
 Windows 2000 Server 
 Windows XP 

Processor and RAM Requirements 
 Windows 98 SE, Pentium 166MHz with 64MB RAM 
 Windows ME, Pentium 166MHz with 64MB RAM 
 Windows NT, PII 300MHz with 64MB RAM 
 Windows 2000 Professional/ME, Pentium 166MHz with 64MB RAM (PII 400MHz with 

128MB RAM recommended) 
 Windows 2000 Server, Pentium 166MHz with 128MB RAM  
 Windows XP, Pentium II 266MHz with 256MB RAM 

Minimum Disk Space requirements  
Additional disk space may be required for logging purposes: 

 30MB network install 
 40MB local install 

Other requirements 
 Network interface card 
 Video support of 800 x 600 resolution with 2MB video memory (minimum)  
 Mouse  
 CD-ROM (if installing the Interaction Supervisor from a CD) 
 Sound card and speakers (recommended) 
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Required access rights 
At startup, Supervisor detects plug-in files and loads them automatically—if you have all 
needed access rights.  Access to a plug-in is controlled by the license file on the IC server and 
by assignment of a license to your station in Interaction Administrator.  Supervisor enforces 
licenses on a per-workstation basis.  The IC's AdminServer subsystem determines the number 
of licenses that are available.   

IC server license file (license.dat) 
When your company purchases rights to use a plug-in, the license file on the IC server 
(license.dat) is updated to report availability of the plug-in, and to set the maximum 
number of station licenses that can be assigned.  The IC system administrator is responsible 
for managing licenses on the server, and may also be the person responsible for assigning a 
license to your station.   

For background information concerning the license installation process, refer to the 
Licensing Overview document, in the Technical Reference Documents section of the IC 
documentation library.  Additional information is available online at 
http://www.inin.com/license. 

Station licenses 
Your station must be granted the right to access the plug-in.  This right is assigned in 
Interaction Administrator by your IC administrator or other authority.  The procedure is as 
follows: 

1. Start Interaction Administrator. 

2. Expand the Server container.   

3. Expand the Stations Space container.  Then click on the Stations container. 

4. Double-click a station in the list view to open its property sheet. 

5. Place a checkmark next to the station licenses you want to assign.  In the example 
below, Station10 has been granted the right to access the Dialer plug-in and the 
Workgroup plug-in. 

 

6. Press OK to close the property sheet.   

7. Repeat steps 4-6 to assign rights to other stations as needed.   

8. Close Interaction Administrator when you are finished. 
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Enforcement of Licenses 

Interaction Supervisor enforces licensing on a per Workstation basis.  The Admin Server 
subsystem determines the number of licenses that are available; Interaction 
Administrator assigns Supervisor licenses to workstations.  If a Workstation does not 
have a license, Supervisor will display a message stating that a license is required to run 
supervisor on the current workstation. 
 
In some cases, Supervisor can run a plug-in but not with its base supervisory 
functionality enabled.  If Supervisor detects that it has been started with no Supervisor 
license enabled, it does not exit.  Instead, it runs licensed plug-ins.  If no plug-ins are 
licensed and base Supervisor functionality is not licensed, Supervisor displays a dialog to 
that effect and exits. 

How Supervisor reacts when licensing is changed on the server 

Supervisor reacts when licensing of plug-ins or views is changed on the IC server.  Each 
plug-in queries for license information when it is opened or when the New dialog is 
displayed.   

The New dialog and plug-in dialogs are updated when they are opened. For example, if the 
New dialog is open and the licensing is changed, changes in licensing won't be reflected 
until the New dialog is reopened. 

Views, on the other hand, cache license information.  Consequently, views are not updated 
until Supervisor is restarted.  If a license is removed, the user does not loose configured 
views until Supervisor is restarted. 

Related Topics 

 Plug-in Architecture (p. 10)  

 Recommended Access Rights (p. 15)  

 Display rights assigned to you (p. 17)  
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Recommended access rights 
Additional permissions must be granted in Interaction Administrator before users can access 
some Interaction Supervisor features.   

Right to view workgroups and workgroup queues  
To access workgroup statistics, a user must have permission to View Workgroups and View 
Workgroup Queues.   

1. Start Interaction Administrator if it is not already running. 

2. Expand the People container.   

3. Expand the Users container. 

4. Double-click a user entry in the list view to open its property sheet. 

5. Click on the Access Control tab.  Then select User Rights in the list on the left. 

6. Select View Workgroup from the Category drop list. 

7. Assign individual workgroups to the user. 

8. Select View Workgroup Queue from the Category drop list. 

9. Assign individual workgroup queues to the user. 

10. Press OK to close the property sheet. 

11. Repeat steps 4-10 to assign permissions to other users as needed.   

12. Close Interaction Administrator when you are finished. 

Allow alerts to send emails or trigger a handler 
To set up alerts that send Email or trigger a handler, the user must be granted permission 
to Allow Handler Trigger Alerts. 

1. Start Interaction Administrator if it is not already running. 

2. Expand the People container.   

3. Expand the Users container. 

4. Double-click a user entry in the list view to open its property sheet. 

5. Click on the Security tab.  Then select User Rights in the list on the left. 

6. Place a checkmark next to Allow Handler Trigger Alerts. 

7. Press OK to close the property sheet. 

8. Repeat steps 4-7 to assign rights to other users as needed.   

9. Close Interaction Administrator when you are finished. 

When you set up an email alert you may notice fields on the Custom Handler tab have 
been modified. In Interaction Supervisor, an email alert is considered a custom alert 
where the customization is already provided.  Administrators can prevent users from 
setting up these email alerts by disabling the Interaction Administrator "Allow Handler 
Trigger Alerts" User Right. This user right is the same permission that allows users to use 
custom alert handlers. 

Allow Supervisor Message Creation 
To send Supervisor Messages, the "Allow Supervisor Message Creation" user right must be 
granted in Interaction Administrator. This right allows a Supervisor user to create messages 
and send them to Interaction Client users.  For details, see Send Messages to Interaction 
Client users (p. 76).  To assign this right, follow these steps: 
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1. Open Interaction Administrator. 

2. Select the Users container. 

3. Open properties for a User by double-clicking an entry in the list view, or press Enter 
to open the currently selected User. 

4. Click on the Security tab. 

5. Select "User Rights 2". 

6. Check "Allow Supervisor Message Creation". 

7. Press OK to close the property sheet. Repeat steps 3-7 for other users who need this 
right.  

8. When you are finished, close Interaction Administrator by selecting Exit from the File 
menu. 

Related Topics 

 Plug-in Architecture (p. 10)  

 Required Access Rights (p. 13)  

 Display rights assigned to you (p. 17)  
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Display rights assigned to you  
To find out which plug-ins you have rights to use, follow these steps: 

1. Start Interaction Supervisor if it is not already running. 

2. Pull down the Help menu and select Plug-In Info.  This dialog lists rights assigned to you 
in Interaction Administrator.  In the example below, the station has the right to use the 
System plug-in, but cannot use the Workstation plug-in. 

 

In this release, access to individual views cannot be restricted.  If you have rights to 
the plug-in, you may access all of its views.  More granular control over view access 
may be provided in a future release. 

3. Press OK to dismiss the dialog. 

Related Topics 

 Required access rights (p. 13)  

 Recommended access rights (p. 15)  

 Plug-in Information dialog (p. 121)  
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Procedures 
This section explains how to perform common tasks in Interaction Supervisor.  The major procedures 
are listed below: 

 Install Interaction Supervisor (p. 19)  explains how to install Supervisor client software on agent 
PCs. 

 Start Interaction Supervisor (p. 22)  covers command-line parameters, call-flow configuration 
switches, and shortcuts used to run the program. 

 Access help topics, web pages and version information (p. 25)  explains how to obtain 
information about the program, statistics, your operating environment, and printable versions of 
help files. 

 Manage Views (p. 29)  explains how to create, customize, and display views in the workspace. 

 Manage Graphs (p. 53)  explains how to create and monitor line graphs and bar charts. 

 Manage Alerts (p. 64)  explains how to set alerts that inform you of events triggered by statistical 
changes. 

 Manage Toolbars (p. 74)  explains how to customize the appearance of toolbars. 

 Change an agent's workgroup activation (p. 75)  explains how to manage which workgroups an 
agent will receive calls for.   

 Exit Supervisor (p. 81)  explains how to close the program safely. 
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Install Interaction Supervisor 
This procedure explains how to install Interaction Supervisor on a client PC.  You can run setup 
from your IC server or directly from xIC Product CD Disc 1. 

Interaction Supervisor does not require Interaction Client to be installed as a prerequisite. 

To install Supervisor from CDROM: 

1. If you have the xIC Product CD Disc 1, insert it into the agent's CD-ROM reader.  Wait a few 
seconds for the "autorun" program to start.  If you do not have the CD-ROM, proceed to step 
3. 

2. Press the Client Workstation button.  When the list of Optional Installs appears, click on the 
Interaction Supervisor hyperlink.  This runs setup.exe from the \Supervisor directory on the 
CD-ROM.  Skip to step 5 now. 

To install Supervisor from your IC Server: 

3. Press the Start button and select Run.  

 

4. Type \\servername\Supervisor\Setup.exe in the Open field, replacing servername with the 
name of your IC server.  Press OK and wait a few seconds for setup to initialize.  A welcome 
screen will appear. 
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5. Press Next to proceed past the welcome screen.  When the Server Name screen appears, 
confirm that the name of your server is entered correctly.  This is the IC server that 
Supervisor will obtain statistics from.  Press Next to proceed. 

 

6. Wait a few seconds for setup to verify the IC server. 

 

7. When the Setup Program Folder screen appears, press Next to accept Interactive Intelligence 
as the target folder.  You can optionally enter a different folder name. 

 

8. Wait until setup finishes copying files to your hard drive. 
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9. Close other running programs, and then press Finish to reboot your machine. 

 

Once your machine is restarted, you can launch Interaction Supervisor by pressing the Start 
button, selecting All Programs, Interactive Intelligence and then Interaction Supervisor.  This 
shortcut can be modified to add optional command line parameters.  See Start Interaction 
Supervisor (p. 22)  for more information.   

To use licensed plug-ins (p. 10) , access rights must be granted to your station.  For 
details, see Required Access Rights (p. 13) , Recommended Access Rights (p. 15) , and 
Display rights assigned to you (p. 17). 

Related Topics 

 Start Interaction Supervisor (p. 22)  

 Product Concepts (p. 7)  
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Start Interaction Supervisor 
Once you have installed Interaction Supervisor, you can follow these steps to start the program:  

1. Press the Start button.   

2. Select All Programs, Interactive Intelligence, and then Interaction Supervisor.  After a few 
seconds, its splash screen will appear.  

3. The default shortcut does not pass any ID and password information to Supervisor.  If you 
specified a different server name during installation, Supervisor will display a "login failed" 
alert.  Press OK to dismiss this message if it appears.   

You can specify user and password information in the shortcut used to start Interaction 
Supervisor.  See command line parameters (p. 23)  for details.   
 
By default, Supervisor uses the name of your computer as the station name.  If your 
computer name does not match the station name defined in Interaction Administrator, 
license authentication will fail unless you start Supervisor using the /w command line 
parameter to specify the station name.  
 
If Supervisor is running on the same station as Interaction Client or another IC application, 
the station used in Supervisor must match the station used in Interaction Client. 
 
If Interaction Client and Supervisor are running on the same machine, and Interaction 
Client is running from a remote dynamic station, then Interaction Client must be started 
before Interaction Supervisor.  That restriction will be lifted in a future release. 

4. If a Login dialog (p. 113)  appears, enter a valid IC username and password. Then specify a 
configuration type (inbound, outbound, operator, or All).  Press OK.  If authentication fails, 
Supervisor redisplays the Login dialog, so that you can correct a typing error or login using a 
different ID.   
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Command line parameters 
Interaction Supervisor supports optional command line parameters that you can use when 
starting Interaction Supervisor.  These parameters are typically added to a shortcut.  
Command-line switches are not case-sensitive.  

Parameter Parameter Description 

/n /n=<server name>. This parameter specifies the IC Server to which you 
point Interaction Supervisor. You can also specify an IP address (like 
204.180.46.8). 

/u /u =<user name>. This parameter allows you to start Interaction 
Supervisor logged in as a different user than the one specified when 
Interaction Supervisor was installed. You might use the /U=<user_name> 
parameter if several people use a computer at different times during the 
day. Specifying the user allows the current user to receive his or her 
personal interactions in addition to the interactions that are placed on the 
computer's station queue. 

/p /p=<password>. This password is specified in Interaction Administrator. 

/w /w=<station name>.  By default, Supervisor uses the name of your 
computer as the station name.  If your computer name does not match 
the station name defined in Interaction Administrator, license 
authentication will fail.  To prevent this, start Supervisor using /w to 
specify the station name.   
 
If Supervisor is running on the same station as Interaction Client or 
another IC application, the station used in Supervisor must match the 
station used in Interaction Client.   
 
If Interaction Client and Supervisor are running on the same machine, and 
Interaction Client is running from a remote dynamic station, then 
Interaction Client must be started before Interaction Supervisor.  That 
restriction will be lifted in a future release. 

/DONT_UPDATE Skips the process of checking the Auto Updater configuration for potential 
updates. 

/LOGIN Opens the login dialog with station and server parameters filled in. 

/ICONS /ICONS=<directory where icons are>. This parameter specifies the local 
directory where your status icons are installed. Use this parameter to 
properly display status icons in your Supervisor pages. 

/NOSPLASH /NOSPLASH. This parameter ignores or suppresses the splash screen that 
is normally displayed during start-up. However, this parameter is usually 
only used for debugging purposes. Check with your administrator before 
using this parameter. 

Example Shortcut 

"C:\Program Files\Interactive Intelligence\SupervisorA.exe" /u=user1 /p=password 
/w=station1 /n=ICServer1 

Related Topics 

 Modify a Shortcut (p. 24)  
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Modify a Shortcut 
To modify the shortcut used to start Interaction Supervisor, follow these steps: 

1. Press the Start button. 

2. Select All Programs, Interactive Intelligence, and then right-click Interaction Supervisor to 
open its context menu. 

3. Select Properties from the context menu. 

4. Modify the Target statement to add Notifier, user, and password arguments. 

5. Press OK.  The next time you start Interaction Supervisor using this shortcut, it will 
connect to the specified server automatically. 

Related Topics 

 Command-line parameters (p. 23)  
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Access help topics, web pages, and version info 
The Help menu provides access to help topics, web resources, and displays version information 
about Supervisor and your computing environment.  Online help is available for Supervisor and for 
each plug-in.  The following procedures explain how to access online help topics: 

 Open the default help topic (p. 26)  

 Display help for a statistic (p. 26)  

 Display help for the object that has focus (p. 26)  

 Toggle display of large graphics in a help topic (p. 26)  

 Display help about a dialog (p. 26)  

 Browse related web pages (p. 27)  

 Display version and system information (p. 27)  

 Open a printable version of the help system (p. 27)  
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Open the default help topic 
To open the help system at its default topic, follow these steps: 

1. Press the Start button. 

2. Select All Programs > Interactive Intelligence > Online Documentation > Interaction 
Supervisor.   

At runtime, help systems for each plug-in are merged with the main help for Interaction 
Supervisor.  The table of contents on the left side of the help window displays an integrated list 
of topics from all help systems. 

Display help for a statistic 
1. To display help for a statistic, press the Help toolbar button ( ).  This puts Supervisor in 

"What's This" help mode.  The cursor changes to a help icon, to indicate that you can click 
on something to open a help topic. 

2. Position the cursor above a statistic and press the left mouse button.   

 

If help is available for the item clicked on, a help topic is displayed.  Otherwise no help is 
displayed. 

Display help for the object that has focus 
To display help for the window or dialog that has focus, press F1.  If specific help for that object 
is not available then the default help topic is displayed instead. 

Toggle display of large graphics in a help topic 
Buttons in the page header allow you to hide large graphics in a help topic to view more text in 
the help window at one time.   This feature is available only in the online help version of this 
publication.  It is not available in printable versions. 

1. To hide large graphics in the current topic, press the Hide Large Graphics button ( ). 

2. To redisplay all graphics, press the Show Large Graphics button ( ).  

Display help about a dialog 
Some dialogs provide a help button that opens a topic describing options on the dialog box.  
That help topic may be linked to higher-level procedures.  Look for "Related Topics" at the 
bottom of the help page. 

Related Topics 

 User Interface Options (p. 82)  

 Dialogs (p. 84)  
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Access online resources 
1. To access online resources in your web browser, pull down the Help menu and select 

About Supervisor…   

2. Press the Contact ININ… button.  A popup menu will appear.   

3. Choose one of the following options from the popup menu: 

 Home—opens the Interactive Intelligence web site using the default web browser 
installed on your computer. 

 Support—opens the Support section of the Interactive Intelligence web site.  An ID 
and password is required to access this section of the site. 

 Community—Takes you to the home page of the Interactive Intelligence Interactive 
Community.  This free and public online service is devoted to the sharing of ideas 
and information regarding Interactive Intelligence software. Opinions expressed on 
the Interactive Community are not those of Interactive Intelligence, and Interactive 
Intelligence accepts no legal responsibility for their veracity or nature. 

 Feedback—displays a web form that you can use to provide feedback about 
Interactive Intelligence products.  You can rate your overall satisfaction, suggest an 
enhancement, or report a bug from this page. 

Display version and system information 
Collectively, these options provide information that may be useful in a technical support 
situation.   However, you do not need to understand these items of data in order to use 
Interaction Supervisor. 

1. For general information about your computing environment, pull down the Help menu and 
select About Supervisor… 

2. Then press IC Info for information about your IC server.  The version number of IC is also 
the version of Interaction Supervisor. 

3. For information about Internet Protocol, press IP Configuration.  When you are finished, 
press Close. 

4. For information about your computer system, press the System Info button.  This opens 
the System Information dialog. 

5. When you are finished, dismiss the dialog by pressing the Close button. 

6. Press OK to close the About IC dialog. 

Open a printable version of the help system 
A printable version of each online help system is provided in Adobe Portable Document Format 
(PDF).  To open "Acrobat" files, you need Adobe® Reader®—free software that views or prints 
PDF files.  The latest version of this software can be downloaded from http://www.adobe.com.  
Once Reader is installed, you can access a printable version of each help system as follows: 

1. Open Supervisor's default help topic, which is a cover page that lists the document title, 
date when last updated, etc. 

http://www.adobe.com/
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2. Click on the hyperlink titled "Printable Version".   If the help system is a compiled HTML 
Help file, the PDF file will open in Acrobat Reader.  If the help system is a WebHelp 
document, the PDF file will open in your web browser.  (To return to the cover page, press 
the browser's "Back" button.) 

3. Once the PDF file is open, you can print it or save a copy to your hard drive.   

4. To access the printable versions of a plug-in help module, click in the tree view to open 
the cover page for the plug-in.  As mentioned earlier, helps for plug-in modules are 
merged into Supervisor's help system at runtime, so these cover pages are lower in the 
tree. 

5. Repeat steps 2-3 to save or print the file.  Repeat steps 4-5 as needed for other plug-in 
helps. 



 

Interaction Supervisor User Guide Page 29 of 139 

Manage Views 
The procedures in this section explain how to create, customize, and position views.   

A view is a window that displays data.  View windows can be positioned anywhere on the screen, 
or docked within Supervisor's workspace.  Views display information in columns, or render 
graphs.   

 Add a view to the workspace (p. 30)  

 Change the caption selection (p. 31)  

 Add or remove statistics from a tabular view (p. 32)  

 Rename a view (p. 33)  

 Use Queue Monitor Controls (p. 34)  

 Switch between floating, docked, or tabbed pages (p. 43)  

 Display view on a tab page (p. 44)  

 Display view in a floating window (p. 46)  

 Display view as a docked window (p. 47)   

 Use Dock button to toggle view state and position (p. 48)  

 Anchor a docked view to another position (p. 49)  

 Close a view (p. 50)  

 Display views in Full Screen mode (p. 51)  

 Display views in Slide Show mode (p. 52)  
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Add a view to the workspace 
To monitor statistics, you must add a new view to the workspace.  The New View command 
opens a dialog that displays available views.  Follow these steps to create a new view: 

1. Issue the New View command using one of the following methods: 

 Press the New button ( ) on the toolbar, or… 

 Press CTRL + N, or… 

 Pull down the File menu and select New…   

2. When the New View (p. 120)  dialog appears, click on the tab that represents the plug-in 
module you want to use.  Or click on the All tab to display a list of views from all plug-ins. 

3. Select the view to add by clicking its name or icon. 

4. Press OK to proceed.   Depending upon the view selected, you may be prompted to select 
data items and properties to display before the new view is added to the workspace.  For 
more information, refer to help topics for the plug-in module. 

Related Topics 

 Manage Views (p. 29)  
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Change the caption selection 
Changing the caption selection updates the view to display statistics for a different item, such 
as a workgroup, workflow, agent, etc.  You choice of selections depends upon the plug-in and 
view.   

There are several ways to change the caption selection.   Some views provide caption bars 
that change the item displayed.  Caption bars are similar to pull-down menus in that they allow 
one item to be selected from a list.   

 

To display statistics for a different item follow these steps: 

1. Make a different selection from the caption bar, if the view provides one.  Or… 

2. Press the Change Caption Selection toolbar button ( ), or by select Change [item name] 
from the custom menu for the view.  For example, the menu selection for a Workgroup 
view is Change Workgroup, while the menu selection for a Dialer view is Change 
Workflow.  The name of the option varies by plug-in and view.  Fortunately, the menu 
choice makes sense within the context of a view. 

3. A dialog will appear to list available selections.   Select an item. Then press OK to dismiss 
the dialog. 

Note—the criteria that you can select varies by plug-in and view.  Once a selection is 
made, Supervisor changes the title of the caption bar where applicable. 

Regardless of the method used to invoke the Change Caption Selection command (p. 82) , a 
different set of data is selected for display.  Changing the caption selection does not change the 
statistics displayed—only their values and the item that they apply to.    

Related Topics 

 Manage Views (p. 29)  

 Change Caption Selection dialog (p. 101)  
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Add or remove statistics from a tabular view 
Supervisor provides granular control over the statistics displayed in the view that you are 
monitoring.  To change the statistics displayed in a tabular view: 

1. Press the Add / Remove Statistics ( ) toolbar button, or… 

2. Select Add / Remove Statistics from a pull down menu, or… 

3. Right-click in a loaded view, and select Add / Remove Statistics from a context menu, or… 

4. Add a new view (p. 30)  that requires selection criteria to be specified before it is 
displayed. 

Statistic Selection dialogs 

Regardless of the method used, a Statistic Selection dialog appears so that you can select 
statistics to include or exclude from the view.  The appearance of this dialog differs for each 
plug-in and view, since it is customized for the data that the view manages.   

 

In general, Statistic Selection dialogs have several features in common: 

 They provide two lists—one that displays data items selected for display in the view, and 
another that list items that you can add to the view.    

 You can press an Add button to move selected items from the Available list to the list 
of items selected for display.   

 Conversely, you can press a Remove button to moves selected items to the Available 
list.  This prevents them from appearing in the view. 

 Up and Down buttons change the order of items in the Selected list, and control the 
display order of items in the view. 

 If the view provides statistics for multiple view categories, controls may appear on tab 
pages.   

Since the functionality and appearance of a Statistic Selection dialog is provided by the plug-in 
and not by Supervisor, you may need to press the Help button to obtain specific information 
about the current dialog. 

Related Topics 

 Add or remove statistics from a graph view (p. 57)  

 Statistic Selection dialog (p. 124)  

 Manage Views (p. 29)  
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Rename a view 

Once you have added a view to the workspace, you can rename the view to distinguish it from 
other views. 

1. Click anywhere in the view to select it. 

2. Choose Rename from the File menu.  Alternately, if the view is displayed on a tab, you 
can right-click the tab to select the Rename command from a context menu.  Either 
method opens the Rename View (p. 123)  dialog. 

 

3. Type a new name in the Name field.  Press OK. 

 

4. If another view has the same name, Interaction Supervisor displays an alert. Once you 
dismiss the alert, you are prompted to rename again. 

 

5. When a unique view name is supplied, Interaction Supervisor displays the new name on 
the view's tab page. 

Related Topics 

 Manage Views (p. 29)  
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Use Queue Monitor Controls  

 
The Queue Monitor control. 

Queue Monitor controls appear on views that display information about lines or queues.  These 
controls provide details about interactions and may allow supervisory actions to be performed 
on a selected item.  For example, the Queue Monitor control for a Lines view allows a 
supervisor to select a line, and then listen, record the conversation, join a conference, etc.  

 

Conference calls are displayed as an expandable list. 

Queue Monitor controls are efficient and can theoretically load 10,000 queue items in less than 
1 second. In practice, network latency slows the process down somewhat.  Queue Monitor 
controls can sort 10,000 items in less than 1 second, and can display them with little noticeable 
delay or flicker.  The speed and performance of Queue Monitor controls is limited only by the 
cache to which the control is connected. 

Default Columns 

The columns below are available in Queue Monitor controls by default.  You can also add 
custom columns (p. 40). 

Call Id 

A system-assigned number that uniquely identifies the interaction object. 

Duration 

Length of time that the interaction has been in effect. 

Line 

Name of the line that this interaction is on.  In some views the name is prefixed by an icon 
that indicates the state of the object (see below). 
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Listen 

 A speaker icon appears in this column if Supervisor is monitoring the Interaction. 

Name 

Descriptive name of the interaction. 

Number 

Telephone number of an interaction member. 

Queue 

The icon in this column indicates the general state of the queue object.  For more 
information about states, see the description of the State column later in this topic. 
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io
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Record 

 A red circle icon appears in this column if Supervisor is recording the Interaction. 

State 

This column indicates the state of the interaction—the current condition of an interaction 
in a queue.  The states that may appear by default in the State column are: 

Dialing Seen for outbound calls. IC dials the outbound 
proceeding interaction. 

Disconnected Seen for both outbound calls and inbound 
interactions. The interaction is no longer active. 

Manual Dialing Seen for outbound calls. A telephone handset 
has been picked up and a dial tone is being 
generated. Calling from the handset will act the 
same as calling from the Client when call 
analysis has not been enabled in Interaction 
Client. Calling from the handset when call 
analysis has been enabled, will show outgoing 
calls as Connected and will continue to ring until 
the call is answered. 

Alerting Seen for inbound interactions. An Interaction 
Client user is notified that he or she has an 
incoming interaction. 

Connected Seen for both outbound calls and inbound 
interactions. The interaction is connected to a 
user or a station. If call analysis is not enabled, 
Connected means the same as Proceeding. 

Held Seen for both outbound and inbound 
interactions. The interaction is on hold. 

Ring No Answer Seen for inbound calls. The call was sent to an 
agent who did not pick up the call. The call timed 
out, and the caller is being presented with 
prompts to determine how he or she wants 
Interaction Client to proceed with the call (send 
to voicemail, try another extension, etc.). 

Voice Mail The caller is leaving a voicemail message. 

Parked The interaction is waiting on a User, Workgroup, 
or Station queue. 

System The interaction is interacting with handlers or 
other components of the IC system. 

Disconnected 
(Local Disconnect) 

Seen for both outbound and inbound 
interactions. The interaction was disconnected 
locally and is no longer active. 

Disconnected 
(Remote 
Disconnect) 

Seen for both outbound and inbound 
interactions. The interaction was disconnected by
the remote party and is no longer active. 

Proceeding Seen for outbound calls. The interaction 
proceeds through the outside telephone network 
and is waiting to be answered. Proceeding is 
used if an Interaction Client user has enabled call
analysis. Calls Proceeding eventually time out if 
the call is not answered. 

Offering Seen for inbound interactions. IC places the 
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interaction in a queue, but the interaction is not 
alerting. IC determines if the called party is 
available to take the interaction. 

Operator Escape The user presses zero to reach an operator from 
any queue. 

ACD – Alerting: 
[Agent’s Name] 

Seen for inbound calls. IC places the call into a 
queue, and sends it to an available agent. 

ACD – Assigned: 
[Agent’s Name] 

Seen for inbound calls. IC placed a call into a 
queue, sent it to an available agent, and the 
agent picked up the call. 

ACD – Wait Agent Seen for inbound calls. IC placed a call into a 
queue, but all agents were busy and IC was 
unable to alert an agent. 

ACD – Wait Agent -
> Last Attempted: 
[Agent’s Name] 

Seen for inbound calls. IC placed a call into a 
queue, sent it to an available agent, but the 
agent did not pick up the call and IC placed it 
back into the queue. 

Queue Timeout Seen for inbound calls. The call waits in a 
timeout queue and times out. The caller is being 
presented with prompts to determine how he or 
she wants Interaction Client to proceed with the 
call (send to voicemail, try another extension, 
etc.). 

Multi-Site Seen on the Lines page for inbound calls. The 
call is in a multi-site state. 

Queue Email 
Alerting: [Agent’s 
Name] 

Seen for inbound email interactions. IC places 
the email into a queue, and sends it to an 
available agent. 

Queue Email 
Connected: 
[Agent’s Name] 

Seen for inbound email interactions. IC placed an
email into a queue, sent it to an available agent, 
and the agent picked up the email. 

Queue Email Not 
Answered: [Agent’s
Name] 

Seen for inbound email interactions. IC placed an
email into a queue, sent it to an available agent, 
but the agent did not pick up the call and IC 
placed it back into the queue. 

Generic Object 
Waiting 

Seen for inbound interactions. IC sends a generic
object to a user queue, but the user is 
unavailable or not logged in. 

Pending Disconnect If the system administrator or application 
developer modifies or customizes a Disconnected 
state strings, this state will appear before the 
Disconnected state. For example, an 
administrator or developer may modify a handler 
to direct IC to send a caller to an IVR survey 
before disconnecting. 

Remote Transfer IC sends an interaction to a user whose status is 
set to Available, Forward, and IC is forwarding 
the interaction based on the user’s call coverage 
settings. 

One Number 
Follow-Me 

IC sends an interaction to a user whose status is 
set to Follow Me, and IC is routing the interaction
based on the user’s Follow Me settings. 

Station 

The station queue where the call is currently located. 
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User 

Name of the user who initiated the interaction. 

Sort Columns 

To change the sort order, click on a column heading to sort by that column.  The last two 
previously sorted columns are used as sub sorts. 

Resize Column Width 

To resize a column, drag the edge of a column heading left or right to narrow or widen the 
column.  

Rearrange Columns 

To change the order of columns, drag and drop a column heading to a new location. 

Actions (Pickup, Disconnect, Join, Listen, Record, Pause, Private, Assistance) 

Queue Monitor controls support the call control actions below (if the view allows them).  These 
actions apply to the item that is selected in the Queue Monitor control.  Supervisor checks with 
Client Services to ensure that the station is valid prior to enabling call controls.  If a station is 
invalid, call control buttons are disabled. 

The call control buttons (Pickup, Disconnect, etc.) on the lines and queues pages do not 
change state until you click on an item.   

Pickup 

Picks up an interaction from the queue.   

Disconnect 

Disconnects the selected interaction. 

Join 

This option creates a conference call between the agent, the customer, and you.  Both the 
agent and the customer can hear your side of the conversation.    

Listen 

Listens in on an interaction, such as a caller leaving a voicemail message, a conversation 
between two parties, or a conference call. This button is disabled if the interaction is not in 
a state in which this action can be performed. The parties being listened to are not aware 
that someone is listening to the interaction. 

Coach 

Click this button to add yourself to an agent's call, in a mode that allows you to speak to 
the agent without being heard by the customer.  This enables you to provide advice to the 
agent without the customer knowing that you are assisting on the call. The agent can hear 
your side of the conversation, but the customer cannot.  

The Coach feature is especially helpful to supervisors who are training new agents, 
monitoring employee customer service performance, or simply providing assistance with a 
customer call. 

Record 

Records the selected interaction. 

Pause 

Controls a recording session by pausing or un-pausing recording.  This button is disabled 
(shaded) if the interaction is not in a state in which this action can be performed. 

Private 

Prevents other users from recording or listening to a conversation.  This button appears 
shaded if the interaction is not in a state in which this action can be performed.  It is also 
disabled if the user does not have security rights to use this feature.  
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Assistance 

Sends a help request to the Supervisor.  Pressing this button opens a dialog box that 
prompts for a description of the problem.   

Related Topics 

 Add custom columns to a Queue Monitor Control (p. 40)  

 Remove custom columns from a Queue Monitor Control (p. 41)  

 Coach an Interaction (p. 42)  

 Manage Views (p. 29)  
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Add custom columns to a Queue Monitor Control 
1. To add custom columns to a Queue Monitor control, right-click in the control and then 

select "Columns…" from the context menu.  This opens the Add / Remove Queue 
Columns dialog (p. 89). 

2. Press the Custom Columns button.   

3. When the Manage Custom Columns dialog (p. 119)  appears, press the Add button.   

4. When the Add Custom Column dialog (p. 87)  appears, enter a descriptive name for 
the attribute in the Display Name field.  The name entered here will appear as the 
name of the column when it is displayed in a Queue Monitor control (p. 34). 

5. Use the Attribute Name drop list to select a predefined object attribute, or type the 
name of a custom attribute.   

6. If you selected a predefined attribute, the Type field is completed automatically.  If 
you entered the name of a custom attribute, then use the Type field to identify its data 
type.  Type can be String, Boolean (Yes/No), Boolean (Check/X), Duration, or Time 
Stamp.   The Queue Monitor control will display the value of the attribute in a format 
that is consistent with its data type: 

 String data is displayed as string data. 

 Boolean (Yes/No) is displayed as "Yes" or "No" in the column. 

 Boolean (Check/X) is displayed as a checkbox or X icon in the column. 

 Duration uses the attribute as a start time and increments every second. 

 Time Stamp displays the Date/Time indicated by the attribute. 

7. Press OK to close the Add Custom Column dialog. 

8. Press OK to close the Manage Custom Columns dialog, or press Add to define another 
column. 

9. Finally, tell the system to display the custom columns, by selecting them in the 
Available list (of the Add / Remove Queue Columns dialog) , and pressing Add to move 
them to the Selected columns list. 

Tip—you can change the display order of columns by using Up/Down arrows to 
move selections in the Selected columns list. 

10. Press OK to close the Add / Remove Queue Columns dialog (p. 89).   

Related Topics 

 Remove custom columns from a Queue Monitor Control (p. 41)  

 Coach an Interaction (p. 42)  

 Use Queue Monitor Controls (p. 34)  

 Manage Views (p. 29)  
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Remove custom columns from a Queue Monitor Control 
1. To remove custom columns from a Queue Monitor control, right-click in the control and 

then select "Columns…" from the context menu.   

2. When the Add / Remove Queue Columns (p. 89)  dialog appears, press the Custom 
Columns button.   

3. When the Manage Custom Columns (p. 119)  dialog appears, select the attribute that 
you want to remove in the Custom Columns list. 

4. Press the Remove button. 

5. Press OK to close the Manage Custom Columns dialog. 

5. Press OK to close the Add / Remove Queue Columns dialog.  The custom column will 
no longer appear in the view. 

Related Topics 

 Add custom columns to a Queue Monitor Control (p. 40)  

 Coach an Interaction (p. 42)  

 Use Queue Monitor Controls (p. 34)  

 Manage Views (p. 29)  
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Coach an Interaction 
Queue Monitor controls provide a Coach button that enables a Supervisor to speak to an 
Agent without being overhead by the customer.  Supervisors can provide advice to an Agent 
without the customer knowing that anyone is assisting with the interaction. The Agent can 
hear the Supervisor's side of the conversation, but the customer cannot.  

This feature is especially helpful to supervisors who are training new Agents, monitoring 
employee customer service performance, or simply providing assistance with a customer 
call. 

To coach an agent on an interaction: 

1. Select the interaction you want to join and click the Coach button. You are now 
connected to the Agent's interaction, enabling you to provide advice to the agent 
without the other party knowing you are assisting on the interaction.  The agent can 
hear your side of the interaction, but the other party cannot. 

2. When you are finished, press the Coach button a second time. It works like a toggle 
switch. 

Related Topics 

 Add custom columns to a Queue Monitor Control (p. 40)  

 Remove custom columns from a Queue Monitor Control (p. 41)  

 Use Queue Monitor Controls (p. 34)  

 Manage Views (p. 29)  
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Switch between floating, docked, or tabbed pages 
Views can be displayed on tabbed pages, as floating windows, or as windows docked around the 
workspace.   

 Display view as a tab page (p. 44)  

 Display view as a floating window (p. 46)  

 Display view as a docked window (p. 47)   

 Use Dock button to toggle view state and position (p. 48)  

 Anchor a docked view to another position (p. 49)  

Related Topics 

 Manage Views (p. 29)  



 

Interaction Supervisor User Guide Page 44 of 139 

Display view on a tab page 
To convert a floating or docked view to a tab, follow these steps: 

1. Right-click on the view's title bar, and then select Tabbed from the context menu. 

 

2. If the view "floats" within the tab page workspace as shown below, press the Maximize 
View button.  Do not maximize Supervisor's main window. 

 

3. This expanded view fills the tab page as shown below. 
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Supervisor does not allow multiple views to appear on one tab.  When you click on a 
tab, its view window becomes the active view in the workspace.  If the view is not 
maximized, the tab page may look odd.  The solution is to maximize the view to fill 
the tab page. 

Related Topics 

 Manage Views (p. 29)  
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Display view in a floating window 
Floating views can be positioned anywhere on the screen and are not constrained to the 
Supervisor window.  Follow these steps to float a view: 

1. Select the view that you wish to float. 

2. If the view does not have a title bar, press the dock button or use one of the Window 
menu commands to redisplay the view with a title bar.   

3. Right-click on the view's title bar to open its context menu. 

4. Select Floating from the menu. 

 

5. Drag the floating window anywhere you like.  Resize as needed. 

An alternate way to float a docked view is to drag and drop it by the title bar to a new 
position outside of the Supervisor window. 

Related Topics 

 Manage Views (p. 29)  
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Display view as a docked window 
If a view is floating or tabbed, you can dock it using drag and drop techniques or context 
menu commands. 

Dock a view by dragging and dropping 

If the view has a title bar, you can dock using a drag and drop technique. 

1. Drag it by the title bar to position it above Supervisor's window.  As you drag the 
window, a rectangle will appear to indicate where the view will dock when you release 
the mouse button.   

2. Release the mouse button. 

Dock a view using the context menu 

If the view has a title bar, it can be docked by issuing a context menu command. 

1. Right-click the title bar to open its context menu. 

2. Select Docked from the menu.  Once the view is docked, you can use the "Docked to" 
command to anchor it to one side of the workspace. 

 

3. Right-click the title bar again to reopen the context menu. 

4. Choose Top, Left, Bottom, or Right. 

Related Topics 

 Manage Views (p. 29)  
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Use Dock button to toggle view state and position 
The Dock button ( ) changes the view state of windows in the workspace and repositions 
docked windows.  This button is in a view's title bar.  It toggles the current view between 
docked and tab views.  If the view is a floating window, it is converted to a tab view.  
Subsequent button presses toggle the view between docked and tabbed states.  As a view 
becomes docked, it is cyclically "docked to" the left, bottom, or right edge of the display.  
Depending upon your point of view, this is handy or slightly disconcerting, since it moves 
the view to a new location on the screen.   

1. Click on a view to make it the active view. 

2. Press the Dock button to change the view state to docked or tabbed.  If the view was 
just docked, it was anchored to the next edge of the display (left, bottom, or right).   

3. If the window is not in the state or position that you want, press Dock button again 
until the view has the position and window state that you want. 

Related Topics 

 Manage Views (p. 29)  
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Anchor a docked view to another position 
Docked views are anchored to the top, left, right, or bottom of the Supervisor's window—
relative to one another, and outside of the workspace.   In other words, if you dock a 
window to the top of the window, and another view is also docked to the top, one view will 
be positioned below the other. 

There are several ways to change the position of a docked window: 

1. You can press the Dock button (p. 48)  to toggle the view state of a window.  When it 
changes a view to a docked state, the view is anchored to its next relative position—
left, bottom, or right. 

2. You can right-click on a view's title bar to open a context menu.  Choose Docked to 
and then choose the anchor (Top, Left, Bottom, or Right). 

 

3. You can drag-and-drop a docked window to dock it to the top, left, bottom, or right.  
To do so, position the mouse on the title bar.  Press and hold the left mouse button 
while dragging the mouse to a new position.  A rectangle will appear to indicate the 
new location of the window.  When you release the mouse button, the view will be 
docked to the new location. 

If you drag a docked window to the workspace, or outside of Supervisor's main window, 
the view becomes floating. 

Related Topics 

 Manage Views (p. 29)  
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Close a View 
There are several ways to close a view: 

1. If the view offers a close button, press that to dismiss the view. 

 

2. You can right-click a tabbed view and choose Close from a context menu: 

 

3. You can close the current view by pulling down the File menu and selecting Close, or by 
clicking the close box for a multiple document interface window, as shown below. 

 

Related Topics 

 Manage Views (p. 29)  
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Display views in Full Screen mode 
When views are displayed in full-screen mode, the workspace is maximized to fill the entire 
screen.  Toolbars, menus, and other non-essential controls are hidden in this mode, which is 
well suited for overhead displays and general monitoring. 

 To enter full-screen mode, press the F11 key or select Full Screen from the View menu. 

 To exit full-screen mode, press F11 again, or press the Close Full Screen button in the 
floating topmost window that appears in the top left corner of the screen. 

 

Related Topics 

 Slide Show Mode (p. 52)  

 Manage Views (p. 29)  
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Display views in Slide Show mode 
Slide Show mode cycles to the next tabbed view every 5 seconds.  This mode makes it easy to 
monitor multiple views using an overhead monitor or kiosk.  Before placing Supervisor in this 
mode, set the display mode of views to tabbed (p. 44).  To do this, right-click on a view's title 
bar, and select tabbed from the context menu. 

Related Topics 

 Full Screen Mode (p. 51)  

 Manage Views (p. 29)  
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Manage Graphs 
Interaction Supervisor supports views that graph statistics in real-time.  Graphical views are 
updated automatically when the value of a statistic changes.  Once a graph view is added (p. 30)  
to the workspace, statistics are rendered as bar graphs or line charts.   

 bar graphs display bars whose lengths are proportional to the value of a statistic.   Bar graphs 
compare similar items (e.g. agent performance, etc.) 

 line charts plot the value of a statistic over time.  Line charts indicate trends and provide a 
record of activity.  

You can customize a graph by selecting commands from its right-click context menu, or by using 
the Graph Configuration (p. 109)  dialog to update many aspects of a graph at once.  In general, 
graph commands apply to three component parts of a graph: 

Rendered Data 

 

The graph itself displays a visual rendering of data.  This can be a line chart, horizontal bar 
chart, or vertical bar chart. 

Caption Bar 

 

Most graphs provide a default caption bar.  The Graph Configuration (p. 56)  dialog allows you 
to define a custom caption. 
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Legend 

 

The legend correlates color-coded bars and lines with statistics.   

Graph-Related Procedures 

 Graph view context menu commands (p. 55)  

 Open the Graph Configuration dialog (p. 56)  

 Add or remove statistics from a graph view (p. 57)  

 Change the graph type (p. 58)   

 Change Group by Criteria (p. 59)  

 Modify the period of a line graph (p. 60)  

 Toggle display of Axis Labels (p. 61)  

 Position legend text (p. 62)  

 Toggle display of values in legends (p. 63)  
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Graph view context menu commands 
Graph views provide a context menu that places frequently-used commands at your fingertips.  
These commands add or remove statistics, render the graph as a line, vertical or horizontal bar 
graph, and change the appearance and layout of legends, labels, and other items.   

1. Right-click in the graph view to open its context menu.   

 

2. Select a command from the list.  The list of commands varies by plug-in and view. 

Related Topics 

 Manage Graphs (p. 53)  
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Open the Graph Configuration dialog 
The Graph Configuration dialog (p. 109)  configures most aspects of a graph, including its type, 
grouping, period, colors, title, axes, and legends.  This dialog puts many options at your 
fingertips and is convenient to use. 

1. To open the dialog, right-click in a graph view and then select Configure Graph from the 
context menu, or… 

2. Pull down the view's custom menu and select Configure Graph. 

3. When the dialog appears, press the Help button for information about the specific options 
that you can configure. 

Related Topics 

 Graph Configuration dialog (p. 109)  

 Manage Graphs (p. 53)  
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Add or remove statistics from a graph view 
1. To modify the set of statistics displayed by a graph, invoke the Add/Remove Statistics 

command as follows: 

 Click the Add / Remove Statistic(s) button ( ), or… 

 Pull down the custom menu for the view.  Then select Add/Remove Statistic(s), or… 

 Right-click anywhere in the graph and choose Add/Remove Statistics from the menu 
that appears.  

2. The dialog or wizard that appears next is specific to the plug-in and view.  The general 
idea is to select one or more statistics to display in the graph.  You may be asked to select 
additional criteria (workflow, campaign, etc), in addition to statistics.  For more 
information, refer to the discussion of the graph view in the help module for the plug-in.  

3. When you close the selection dialog, Supervisor will update the display within a few 
seconds. 

Related Topics 

 Manage Graphs (p. 53)  
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Change the graph type 
Interaction Supervisor makes it easy to switch between line and bar graphs.  There are several 
ways to do this: 

Context menu method 

1. Right-click in a graph view and choose Graph Type from the context menu.   

 

2. Choose Line, Vertical Bar, or Horizontal Bar.   

Pull-down menu 

The same menu is available in Supervisor's menu bar: 

1. Pull down the menu added by the view (e.g. Workgroup, System, Dialer, etc.) and select 
Graph Type.   

2. Choose Line, Vertical Bar, or Horizontal Bar.   

Toolbar Options 

To change graph type by pressing toolbar buttons: 

1. Click anywhere in the graph to give it focus. 

2. Press one of the following toolbar buttons: 

 Vertical Bar Graph 

 Horizontal Bar Graph 

 Line Graph 

Related Topics 

 Manage Graphs (p. 53)  
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Change Group by Criteria 
The Group by menu command changes the grouping of statistics in some way. For example, 
you might group by workgroups or statistics.  The figure below shows the same graph, grouped 
by Workgroup, and grouped by Statistic: 

 

Related Topics 

 Manage Graphs (p. 53)  
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Modify the period of a line graph 
Line graphs plot values over time.  Changing the period of a line graph selects statistics for a 
specific time period: 

1. Right-click anywhere in the graph and choose Graph Period from the context menu, or pull 
down the plug-in menu and choose Graph Period.   

Tip—if the Graph Period command is disabled, you can enable it by changing the graph 
type to a line graph. 

2. Select a period of time to graph.  (e.g. 5 minutes, 30 minutes, 4 hours, 8 hours, etc.) 

3. Wait for Supervisor to update the display.  This may take a few seconds, depending upon 
the scope of data that it must select. 

Related Topics 

 Manage Graphs (p. 53)  
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Toggle display of Axis Labels 
The Show Axis Labels command toggles the display of axis labels on or off.  You may view axis 
labels to enhance information shown on your graph, or you may remove them to unclutter the 
display. 

1. To toggle axis labels on or off, use one of the following methods to issue the Show Axis 
Labels command: 

 Pull down the custom menu for the view and select Show Axis Labels, or… 

 Right-click anywhere in the view. Then select Show Axis Labels from the context 
menu. 

 
Axis labels on 

2. A checkmark appears in the menu to indicate whether or not Axis labels are currently 
displayed.  Issue the command again to toggle the display state. 

 
Axis labels off 

Related Topics 

 Manage Graphs (p. 53)  
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Position legend text 
You can move the graph’s legend to the left, bottom, or right side of the graph. 

1. Right-click anywhere in the graph and choose Show Legend on > from the context menu, 
or pull down the view's custom menu and select Show Legend on. 

2. Choose to display the legend on the bottom of the graph, or to the right of the graph.  

 
Legend on right 

 
Legend on left 

 
Legend on bottom 

Related Topics 

 Manage Graphs (p. 53)  
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Toggle display of values in legends 
You can display the current value of each statistic in the graph's legend.  The Show Values in 
Legend command toggles display of values on or off. 

1. Right-click anywhere in the graph and choose Show Values in Legend from the context 
menu. Or choose Show Values in Legend from the custom menu for the view. 

 
When Show Values is on, the value of each statistic appears next to its legend. 

2. Repeat to toggle the display on or off. 

Related Topics 

 Manage Graphs (p. 53)  
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Manage Alerts 
An alert notifies when a statistic is in or out of a user-defined range, based on the value of a 
statistic or condition on the IC Server.  When an alert becomes active, it can play a sound, change 
the color of text or an icon, send an Email, or initiate a handler. 

 

In the example above, the current value of the "Total Agents" statistic is within a range of a values 
specified by an alert.  The alert is configured to paint the icon and text red when it is active.  It 
could just as easily send an email, play a sound, or invoke a handler.  You can set as many alerts 
as you like, including multiple alerts for the same statistic.  An alert can provide any combination of 
available notifications. 

Related Procedures  

 Add an Alert (p. 65)  

 Add Multiple Alerts (p. 66)  

 Add a Time in Status Alert (p. 67)  

 Edit Time in Status Alerts (p. 68)  

 Change the color of an alert icon (p. 69)  

 Edit an Alert (p. 70)  

 Remove an Alert (p. 71)  

 View Active Alerts (p. 72)  

 Manage all Alerts at once (p. 73)  



 

Interaction Supervisor User Guide Page 65 of 139 

Add an Alert 
This procedure explains how to add an alert that notifies you when a statistic is in or out of a 
chosen range, based on statistical items or values on the IC Server.  An active alert can change 
the color of the display, play a wave file, display an icon in your system tray, send electronic 
mail, or invoke a handler. 

1. Right-click a statistical item in a view.  Then choose Edit Alerts… from the context menu 
that appears.  

Tip—can optionally choose Edit Alerts from the pull-down menu for the View.  The name 
of the menu varies depending upon the plug-in and view that is active.  

2. Use the Edit Alerts dialog (p. 106)  to select a statistic.  This dialog displays different 
options in accordance with data items used by the active view.   

3. Once you have selected a statistic, press the Add Range button.  This opens the Alert 
Properties dialog (p. 91) , so that you can define a range of "From" and "To" values for the 
statistic, and notification details. 

4. Complete the Alert Properties dialog by selecting a range of values for the alert, the 
manner in which the alert will notify (by changing colors in the display, playing a sound, 
sending an Email, or invoking a handler). 

5. Press OK to put the new alert into effect. 

6. Press Close to dismiss the Edit Alerts dialog. 

Related Topics 

 Manage Alerts (p. 64)  
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Add Multiple Alerts 
This procedure explains how to add multiple new alerts at one time by selecting one statistic 
and several items (workgroups, workflows, campaigns, sites, agents, etc.) to monitor.   

An alert that notifies you when a statistic is in or out of a chosen range, based on statistical 
items or values on the IC Server.  An active alert can change the color of the display, play a 
wave file, display an icon in your system tray, send electronic mail, or invoke a handler. 

The Add Multiple Alerts command is not supported in all views.  If a view supports it, you can 
add multiple alerts as follows: 

1. Right-click in the view and select Add Multiple Alerts from the view's context menu, or 
select Add Multiple Alerts from the view's custom menu.  The name of the pull down menu 
varies depending upon the plug-in and view that is active. 

2. When the Add Multiple Alerts dialog (p. 88)  appears, select a statistic and items to alert 
on.  The appearance of this dialog varies so that you can select items that are appropriate 
for the plug-in and view.  Regardless of GUI differences, your job is to select multiple 
items (workgroup, workflow, campaign, agent, etc.) and one statistic to alert on.   

For example, the Dialer plug-in prompts you to select a combination of workflow, 
campaign, site, and agent items, in addition to statistic.  Conversely, setting multiple 
alerts for a Workgroup Detail view is a simple matter of selecting workgroup items and 
one statistic.  If this sounds complicated, don't worry.  When the dialog is viewed in 
context, these on-screen options make sense. 

3. Next, press the Add Range button.  It opens the Alert Properties dialog (p. 91) , so that 
you can define a range of "From" and "To" values for the statistic, and notification details. 

4. Complete the Alert Properties dialog by selecting a range of values for the alert, the 
manner in which the alert will notify (by changing colors in the display, playing a sound, 
sending an Email, or invoking a handler). 

5. Press OK to put the new alert into effect.  Interaction Supervisor displays a message that 
indicates the number of new alerts added. 

6. Press OK to dismiss this message. 

7. Press Close to dismiss the Edit Alerts dialog. 

Related Topics 

 Manage Alerts (p. 64)  
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Add a Time in Status Alert 
Alerts of this type notify when an agent is in a particular status for more than a specified 
duration.  Time in status alerts are like regular alerts, except that they examine an agent's 
status (Available, At Lunch, etc.) instead of a workgroup or queue statistic.  Time in status 
alerts are available in views that provide a member list.  Follow these steps to set a time in 
status alert: 

1. Right-click a member row and select Time in Status Alerts… 

 

2. Select a status to base the alert on. 

 

3. Press the Add Range button.  It opens the Alert Properties dialog (p. 91) , so that you can 
define a ranges and notification details. 

4. Complete the Alert Properties dialog by selecting a range of minutes for the alert, the 
manner in which the alert will notify (by changing colors in the display, playing a sound, 
sending an Email, or invoking a handler). 

5. Press OK to dismiss the Alert Properties dialog.   

6. Press Close to dismiss the Edit Alerts dialog. 

Related Topics 

 Edit Time in Status Alerts (p. 68)  

 Manage Alerts (p. 64)  
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Edit Time in Status Alerts 
Follow these steps to edit an agent's "time in status" alerts: 

1. Right-click a member detail row and select Time in Status Alerts… 

 

2. When the Edit Alerts dialog appears, select the alert you want to edit.  Then press the Edit 
Range button. 

 

3. Use the Alert Properties dialog (p. 91)  to modify the range of minutes for the alert, the 
manner in which the alert will notify (by changing colors in the display, playing a sound, 
sending an Email, or invoking a handler). 

4. Press OK to dismiss the Alert Properties dialog.   

5. Press Close to dismiss the Edit Alerts dialog. 

Related Topics 

 Add Time in Status Alerts (p. 67)  

 Manage Alerts (p. 64)  
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Change the color of an alert icon 
This procedure explains how to change the color of the alert icon displayed when an alert is 
active. 

1. Right-click the statistic whose alert icon you want to change.  Then choose Edit Alerts 
from the context menu. The Edit Alerts (p. 106)  dialog box opens. 

2. Highlight the alert whose icon you want to change and click the Edit Range… button. 

3. Click the Icon pull-down menu and choose the new icon you want to use for this alert. 

4. Press the OK button to close the Alert Properties (p. 91)  dialog. 

5. Press the Close button to dismiss the Edit Alerts dialog. 

Related Topics 

 Manage Alerts (p. 64)  
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Edit an Alert 
Editing an alert allows you to change the values watched for a statistic, the icon that appears 
when the alert is active, and the notification that occurs.    

This procedure sets up an alert that operates on a statistic.  To set an alert based upon 
agent status, see Add a Time in Status Alert (p. 67)  and Edit a Time in Status Alert (p. 68). 

1. The Open the Edit Alerts (p. 106)  dialog using one of the following methods: 

 Right-click a statistical item in a view.  Then choose Edit Alerts… from the context 
menu that appears, or… 

 Pull down the View menu and select Active Alerts (or double-click the Supervisor tray 
icon).  Right-click on the alert you want to change and then choose Edit Alert from 
the context menu.   

2. When the Edit Alerts (p. 106)  dialog appears, select an alert range.  Then press the Edit 
Range button to open the Alert Properties dialog (p. 91). 

3. Use the Alert Properties dialog (p. 91)  to change the range of values watched for the 
alert, or to define the manner in which the alert will notify (by changing colors in the 
display, playing a sound, sending an Email, or invoking a handler). 

4. Press OK to close the Alert Properties dialog. 

5. Press Close to dismiss the Edit Alerts dialog. 

6. Press Close to dismiss the Active Alerts dialog (if it is open). 

Related Topics 

 Manage Alerts (p. 64)  



 

Interaction Supervisor User Guide Page 71 of 139 

Remove an Alert 
1. To remove an alert, double-click the tray icon to display the Active Alerts (p. 85)  dialog. 

2. Select the alerts that you want to remove by Ctrl-clicking entries in the list. 

3. Right-click in the list to display its context menu.  Choose Remove Alerts(s). 

4. Press Yes to confirm that you want to remove the selected alerts. 

 

Related Topics 

 Manage Alerts (p. 64)  
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View Active Alerts 
To display the status of active alerts, open the Active Alerts (p. 85)  dialog. It displays the 
current value of each alert statistic, the time when the alert occurred, and other information.  
There are several ways to open this dialog: 

1. Pull down the View menu and select Active Alerts, or… 

2. Right-click the system tray icon (p. 131)  and select Show Active Alerts from a context 
menu, or… 

3. Double-click the alert icon in your system tray.   

Related Topics 

 Manage Alerts (p. 64)  
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Manage all alerts at once 

 

The Manage Alerts dialog makes it easy to manage all alerts in one place. Its purpose is to help 
users administrate their alerts.  Users can view alerts they have set up, edit, and remove 
alerts.   

Alerts can also be listed by category. There are two special categories.  "[All Alerts]" shows all 
alerts regardless of category.  "[Overview]" shows totals by category and grand totals.  The 
dialog also provides a Look For feature that allows alerts listed for the category to be filtered 
down to only those containing a matching search string. 

To open this dialog, select Manage Alerts from the View menu.  You can filter the list of alerts to 
display a subset,  or view categorical lists.  For details, see Manage Alerts dialog (p. 116). 

Related Topics 

 Manage Alerts dialog (p. 116)  

 Manage Alerts (p. 64)  
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Manage Toolbars 
Interaction Supervisor supports docking toolbars, and allows toolbars to be customized.  Users can 
choose which toolbars to display, create a new toolbar, and control toolbar options.  All toolbars are 
customizable, including toolbars added by a plug-in. 

Show / Hide toolbars 
1. To customize the appearance of toolbars, select Toolbars from the View menu.  This opens 

the Toolbar Options (p. 128)  dialog. 

2. To add or remove toolbars from the display, click on the Toolbars tab (p. 128)   of the 
Toolbar Options dialog.  Place a checkbox next to the names of toolbars that you want to 
display.  Uncheck items in the Toolbar list that you do not wish to see. 

3. Use the checkboxes to display tool tips and to apply a borderless "cool" look to toolbar 
buttons. 

Add custom toolbar 
1. To create a custom toolbar that you can position anywhere on the screen, click on the 

Toolbars tab (p. 128).    

2. Press New. 

3. Type a short descriptive name and press OK. 

 

4. To add buttons to a custom toolbar, select the Toolbar Buttons tab (p. 130).  Then drag 
and drop toolbar icons to your custom toolbar.  

Drag and Drop toolbar buttons 
1. To copy buttons from one toolbar to another, select the Buttons tab (p. 130).   

2. Then select a toolbar in the list to display its buttons.   

3. Drag and drop buttons to copy them to another toolbar. 

Related Topics 

 Toolbar Options dialog (p. 128)  
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Change an Agent's workgroup activation 
Workgroup activation allows an agent to be a member of multiple workgroups, while at the same 
time allowing the supervisor to specify the workgroup queues for which he or she will take calls. 

1. Add a view that supports a member list of agents.  For example, the Workgroup plug-in 
provides a Workgroup Detail view that lists agents. 

2. Right-click on the row for the agent whose workgroup membership you want to manage.  
Then select Manage User… from the context menu.  

3. Use the Manage Agent Activations (p. 114)  dialog to see which workgroups the user is 
activated on, and to change activation settings as needed.  This dialog lists the workgroups 
that an agent belongs to, and allows the agent to be set as active or inactive within each 
workgroup.   

If a padlock icon appears next to the workgroup name and the name is grayed out, this 
indicates that the right to activate or deactivate members of the workgroup has not been 
assigned to you in Interaction Administrator.  See Recommended Access rights (p. 15). 

4. To activate the agent for a workgroup, select it in the Member of list on the left.  Then press 
the Add button.  This moves the workgroup to the Activated on list, so that the agent will 
receive calls for that workgroup. 

5. To deactivate the agent from a workgroup, select it in the Activated on list on the right.  Then 
press the Remove button. This moves the workgroup to the Member of list, preventing the 
agent from receiving calls for that group. 

6. When you are finished, press OK to close the dialog. 

Related Topics 

 Manage Agent Activations dialog (p. 114)  
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Send Messages to Interaction Client users 

Supervisor Messages 

Interaction Supervisor can send messages to Interaction Client users. Administrators can send a 
one-time informational message, or use an alert (p. 98)  to automatically trigger messages based 
on any real-time statistic that Supervisor can monitor. For example, an Administrator might 
configure an alert to send a message when there are too many calls in queue, or when a queue's 
wait time is too long. 

This client messaging feature helps IC Administrators keep users and workgroups informed. When 
messages are sent, the Administrator can control the manner in which a message is displayed in 
the client; either as a pop-up or as a scrolling notification along the bottom edge of the client 
window.   

Required Right 

The ability to send messages from Supervisor is governed by an IC user right.  Supervisor users 
who have been granted the Allow Supervisor Message Creation (p. 15)  user right in Interaction 
Administrator can create messages and send them to Interaction Client users.  (See list of 
supported clients below.) 

When the user does not have "Allow Supervisor Message Creation" right, the Create Message 
command is disabled in the toolbar and File menu. The View Messages command remains 
available, but pushbuttons for adding, removing, or editing messages are disabled.  Similarly, all 
options on the Supervisor Message (p. 98)  tab of the Edit Alert dialog are disabled. 

Supported Clients  

Interaction Client Win32 Edition Client messaging is not supported. 

Interaction Client .NET Edition Client messaging is supported.  

Interaction Client Outlook Edition Client messaging is supported. 

Interaction Client Web Edition Client messaging is supported. However, all messages are 
displayed as pop-ups. 

Messages can be sent to individual users, or to a single workgroup or to multiple workgroups. 
Messages are created using the Create Supervisor Message (p. 103)  dialog.  Saved messages are 
managed in the View Supervisor Messages (p. 126)  dialog.  To view sent messages, pull down the 
View menu and select Supervisor Messages. 

Since Supervisor messages are not Emails, they are not processed by Email servers.  Instead, 
messages are held on the IC server until they expire or are manually removed.  When a message is 
composed, the sender selects a preferred display method.  Messages can be displayed as ticker-
tape notifications along the bottom of the Client interface, or as pop-ups.  As you might expect, 
message presentation varies slightly between clients editions. For details, please consult the online 
help for the client you use.   

Notification Messages 

In general, notification messages look like stock tickers when they are displayed at the bottom of 
the Interaction Client window.   

 

Messages move into the notification area by rotating in from the bottom while the current message 
rotates out the top.  To allow time for the user to read the message, there is a pause of several 
seconds between the time the message is fully rotated in and the time it begins cycling to the next 
message. 

Pop-Ups 

When the pop-up option is selected, messages are displayed in a secondary window.  



 

Interaction Supervisor User Guide Page 77 of 139 

 

Related Procedures 

 Compose a new Supervisor message (p. 78)  

 Reuse a previously sent message (p. 79)  

 Remove a saved message (p. 80)  

Related Topics 

 Allow Supervisor Message Creation (p. 15)  

 Create Supervisor Message dialog (p. 103)  

 View Supervisor Messages dialog (p. 126)  

 Supervisor Alert Message Page (p. 98)  
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Compose a new Supervisor message 
To compose a new Supervisor message, follow these steps: 

1. Pull down the File menu and select Create Message, or press the  toolbar button.  The 
Create Supervisor Message (p. 103)  dialog will appear. 

Tip—you can also create new messages when the View Supervisor Messages (p. 126)  
dialog is open, by pressing the New button. 

2. To select one or more recipients for the message, press the To button.  Use the Recipients 
(p. 122)  dialog to select Users and/or Workgroups.  When you are finished, press OK to 
close the Recipients dialog. 

3. Bu default, the message will be sent as a notification that scrolls across the bottom of the 
client window.  To display the message in a message box, check Send as Desktop Pop-up. 

4. Optionally use the Expire Message After options to automatically remove the message 
after a specified period of time.  Messages will be held on the server until the expiration 
timer expires, after which they are deleted.  Messages that do not expire are saved on the 
server until they are manually removed (p. 80). 

5. Optionally select a sound to play when the message arrives. 

6. Optionally select an icon for the message. 

7. Optionally include a URL with the message. 

8. Press Send to transmit the message. 

Related Topics 

 Send Messages to Interaction Client users (p. 76)   
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Reuse a previously sent message 
1. Interaction Supervisor automatically saves sent messages on the IC server.  To edit and 

reuse a saved message, press the  toolbar button, or pull down the View menu and 
select Supervisor Messages.  The View Supervisor Messages (p. 126)  dialog will appear. 

2. Select a message in the list. 

3. Press Edit to open the message in the Create Supervisor Message (p. 103)  dialog.   

4. Edit delivery options and/or to change the destination.  

5. Press Send. 

6. Repeat steps 2-5 to edit other messages as needed. 

7. When you are finished, press OK to close the View Supervisor Messages dialog. 

Related Topics 

 Send Messages to Interaction Client users (p. 76)   



 

Interaction Supervisor User Guide Page 80 of 139 

Remove a saved message 
1. Interaction Supervisor stores all messages on the server until they expire or until you 

manually delete them.  To remove a message, press the  toolbar button, or pull down 
the View menu and select Supervisor Messages.  The View Supervisor Messages (p. 126)  
dialog will appear. 

2. Select a message to remove. 

3. Press the Remove button.  When a message is removed from this list, it is removed from 
the recipient's client also. 

4. Repeat steps 2-4 to remove other messages as needed. 

5. When you are finished, press OK to close the View Supervisor Messages dialog. 

Related Topics 

 Send Messages to Interaction Client users (p. 76)   



 

Interaction Supervisor User Guide Page 81 of 139 

Exit Supervisor 
The Exit command terminates Interaction Supervisor.  The workspace (including alerts) is 
automatically saved.  When the program is restarted, views, graphs and alerts are restored. 

1. Pull down the File menu and select Exit, or… 

2. Right-click the tray icon to display its context menu.  Choose Exit Supervisor, or… 

3. Close Interaction Supervisor's main window by pressing the close box. 

Tech Support Note: In extremely rare cases, the registry key that Supervisor uses to store 
session configuration data can become corrupt. When this happens, Supervisor generates an 
Application Error when it is closed, followed by the "Interaction Process Restarting" dialog.  
Supervisor restarts normally, but without displaying custom views, alerts, and other user-
specific defaults. 
 
The workaround is to delete the server key that stores the current configuration.  That will allow 
Supervisor to save user information to the registry. To remove the key, stop Supervisor, and 
then use a registry editor to delete: 
 
HKEY_CURRENT_USER\Software\Interactive Intelligence\Interaction Supervisor\IC2.3\<Server> 
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User Interface Options 
This section describes commands (p. 82)  that Interaction Supervisor supports and options that you 
can configure in dialogs (p. 84).  Links to related procedures are provided where applicable. 

Commands 
Commands are invoked using toolbars and menus.  The table below lists each command, its toolbar 
equivalent, menu item, and procedure that describes its function, where applicable.  In the list 
below, [plug-in] is a moniker for the name of the plug-in specific menu displayed when a view has 
focus. 

Command Icon Menu Option Description / Related Procedure 

About - Help > About Supervisor Display version and system information 
(p. 27). 

Active Alerts - View > Active Alerts Displays information about active alerts 
(p. 72). 

Add Multiple 
Alerts 

- [plug-in] > Add Multiple 
Alerts 

The Add Multiple Alerts (p. 66)  command is 
not supported in all views.  It allows you to 
define multiple alerts at one time by selecting 
one statistic and several workgroups to 
monitor.   

Add/Remove 
Statistics  

[plug-in] > Add / Remove 
Statistic(s)… 

Add or remove statistics (p. 32)  from the view 
you are monitoring. 

Arrange Icons - Window > Arrange Icons Arranges minimized windows in the workspace. 

Cascade - Window > Cascade Cascades view window in the workspace. 

Change Station - File > Change Station Use a different workstation (p. 102). 

Change Caption 
Selection 

 Press Caption Bar control 
in a view or [plug-in] > 
Change [item name] 
menu option 

Changes the caption selection (p. 31)  for the 
current view.  This changes the criteria used to 
select data for the view. 

Close (view) - File > Close Closes a view (p. 50). 

Configure 
Graph… 

 [plug-in] > Configure 
Graph 

Opens the Graph Configuration (p. 109)  
dialog, so that you can modify major aspects of 
a graph, such as its type, grouping, period, 
colors, title, axes, and legends. 

Contents - Help > Contents Displays help system contents tab.  

Copy - Edit > Copy Copies selected text to the clipboard. 

Create Message  File > Create Message Composes a new Supervisor Message (p. 76)  
for delivery to Interaction Client users. 

Cut - Edit > Cut Cuts selected text to the clipboard. 

Display Help for 
a Statistic or 
visual control 

 Help > What's This? Puts Supervisor in "What's This" help mode.  
The cursor changes to a help icon, to indicate 
that you can click on a visual control to open 
the help topic that explains it.  This is 
commonly used to display help for a statistic 
(p. 26).  See access help topics, web pages, 
and version info (p. 25)  for information about 
the Help menu. 

Display Vertical 
Bar Graph 

 [plug-in] > Graph Type > 
Vertical Bar 

Changes the graph type (p. 58)  to a vertical 
bar graph. 

Display Vertical 
Bar Graph 

 [plug-in] > Graph Type > 
Horizontal Bar 

Changes the graph type (p. 58)  to a horizontal 
bar graph. 
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Display Vertical 
Bar Graph 

 [plug-in] > Graph Type > 
Line 

Changes the graph type (p. 58)  to a line 
graph. 

Edit Alerts 
 

[plug-in] > Edit Alerts… Opens the Edit Alerts dialog (p. 106)  so that 
you can manage alerts (p. 64). 

Exit - File > Exit Exit Supervisor (p. 81). 

Full Screen - View > Full Screen Display views in Full Screen mode (p. 51). 

Graph Period -  [plug-in] > Graph Period Selects the time period for a line graph to plot.  
See modify the period of a line graph (p. 60). 

Index - Help > Index Displays help system index tab. 

New (view)  File > New Adds a view (p. 30)  to the workspace. 

Paste - Edit > Paste Pastes contents of clipboard to control that has 
focus. 

Plug-in Info - Help > Plug-in Info… Displays plug-in rights assigned to you (p. 17). 

Rename (view) - File > Rename Renames a view (p. 33). 

Search - Help > Search Displays help system search tab. 

Show Axis 
Labels 

- [plug-in] > Show Axis 
Labels 

Toggles the display of axis labels (p. 61)  on or 
off. 

Show Legend on - [plug-in] > Show Legend 
on > Left/Bottom/Right 

Positions legend text (p. 62)  on the left, right, 
or bottom side of the graph view. 

Show Legend 
Values 

 [plug-in] > Show Values 
in Legend 

Toggles the display of values in the legend of a 
graph. 

Slide Show - View > Slide Show Display views in Slide Show mode (p. 52). 

Status Bar - View > Status Bar Toggles display of the status bar on or off. 

Tile - Window > Tile Tiles view windows in the workspace. 

Toolbars - View > Toolbars Manage Toolbars (p. 74). 

Undo - Edit > Undo Reverts the last undoable operation. 

View Supervisor 
Messages 

 View > Supervisor 
Messages 

Opens the View Supervisor Messages (p. 126)  
dialog, so that you can add, edit, or remove 
Supervisor messages. 
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Dialogs 
This section discusses configurable options in dialogs.   

 Active Alerts (p. 85)  dialog 

 Add Custom Column (p. 87)  dialog 

 Add Multiple Alerts dialog (p. 88)  

 Add / Remove Queue Columns (p. 89)  dialog 

 Alert Properties (p. 91)  dialog 

 Change Caption Selection (p. 101)  dialog 

 Change Station dialog (p. 102)  

 Create Supervisor Message (p. 103)  dialog 

 Custom Toolbar Name (p. 105)  dialog 

 Edit Alerts (p. 106)  dialog 

 Filter Settings (p. 108)  dialog 

 Graph Configuration (p. 109)  dialog 

 Interaction Supervisor Login (p. 113)  dialog 

 Manage Agent Activations (p. 114)  dialog 

 Manage Alerts dialog (p. 116)  

 Manage Custom Columns (p. 119)  dialog 

 New View (p. 120)  dialog 

 Plug-in Information (p. 121)  dialog 

 Recipients (p. 122)  dialog 

 Rename View (p. 123)  dialog 

 Statistic Selection (p. 124)  dialog 

 View Supervisor Messages (p. 126)  dialog 

 Toolbar Options (p. 128)  dialog 

 Tray Icon (p. 131)   
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Active Alerts dialog 

 

The Active Alerts dialog box displays the status of the current alerts you have set.  It displays 
the name of the plug-in and view, the statistic examined by each alert, the time when the alert 
occurred, the current value of the statistic, and its event ID.    

Columns in the List Control 
The list control displays about the plug-in and view (entity), the statistic examined by the 
alert, the time the alert occurred, the current value of the statistic, and its event ID.   If you 
right-click a row in the list, a context menu appears, providing the option to edit (p. 70)  or 
remove (p. 71)  the selected alert. 

Entity column 

This column indicates which plug-in and view the alert is manage by. 

Statistic column 

The statistic that this alert notifies about. 

Time Alert Occurred column 

The time when the alert was triggered. 

Current Value column 

The current value of the statistic. 

Event ID column 

The event ID number of the alert.  An event ID is unique number that identifies the 
alert event.  It is similar to a Call ID for telephone calls.  This number is significant 
only if a problem occurs and you are asked by a support representative to identify the 
alert event for diagnostic purposes. 

Color Coded Icons 

The color coded icons at the bottom of the dialog indicate the number of alerts that are 
active for a particular color—not the number of alerts that are set for each color.  In 
general, Red is assigned to warnings, Yellow is assigned to Critical errors, Green is 
assigned to Normal conditions, and Gray indicates Neutral.   

Close Button 

Closes the Active Alerts dialog. 



 

Interaction Supervisor User Guide Page 86 of 139 

Red (Warning) Indicator and Count 
The red warning icon indicates the number of warnings that are active. 

Yellow (Critical) Indicator and Count 
The yellow icon indicates the number of critical alerts that are active. 

Green (Normal) Indicator and Count 
The green icon indicates the number of normal alerts that are active. 

Gray (Neutral) Indicator and Count 
The gray icon indicates the number of neutral alerts that are active. 

Context Menu Commands 
If you right-click an item in the list, a context menu appears that contains these commands: 

Edit Alert… 

Opens the Edit Alerts (p. 106)  dialog.  See Edit an Alert (p. 70)  for details. 

Remove Alert(s) 

Prompts to remove alerts that you have selected in the list.  If you confirm the 
operation by selecting Yes, all selected alerts are removed. 

 

Related Topics 

 Manage Alerts (p. 64)  
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Add Custom Column dialog 

 

This dialog appears when the Add button is pressed from the Manage Custom Columns (p. 119)  
dialog.  It defines a custom contact column that can be displayed by a Queue Monitor control 
(p. 34). 

Display Name 

The descriptive name entered here will appear as the name of the column when it is 
displayed in a Queue Monitor control (p. 34). 

Attribute Name 

Use this drop list to select a predefined object attribute, or type the name of a custom 
attribute.  If you type the name of a custom attribute, you must specify its data type in 
the Type Field. 

Type 

This field identifies the data type of the attribute, which can be String, Boolean (Yes/No), 
Boolean (Check/X), Duration, or Time Stamp.  If you select a predefined attribute in the 
Attribute Name list, this information is selected automatically.  If you typed the name of a 
custom attribute, you must make a selection from this list. 

The Queue Monitor control will display the value of the attribute in a format that is 
consistent with its data type: 

 String data is displayed as string data. 

 Boolean (Yes/No) is displayed as "Yes" or "No" in the column. 

 Boolean (Check/X) is displayed as a checkbox or X icon in the column. 

 Duration uses the attribute as a start time and increments every second. 

 Time Stamp displays the Date/Time indicated by the attribute. 

OK button 

Closes the dialog and applies changes made. 

Cancel button 

Discards changes and closes the dialog. 

Help button 

Opens this help topic. 

Related Topics 

 Use Queue Monitor Controls (p. 34)  

 Add custom columns to a Queue Monitor Control (p. 40)  
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Add Multiple Alerts dialog 

 

This dialog is used to add multiple new alerts at one time by selecting one statistic and several 
items to monitor.  The appearance of this dialog varies so that you can select items that are 
appropriate for the plug-in and view.  Regardless of GUI differences, your job is to select 
multiple items (workgroup, workflow, campaign, agent, etc.) and one statistic to alert on. 

An alert that notifies you when a statistic is in or out of a chosen range, based on statistical 
items or values on the IC Server.  An active alert can change the color of the display, play a 
wave file, display an icon in your system tray, send electronic mail, or invoke a handler. 

Add "Multiple Alerts For" frame 

The options in this frame select the type of item that the statistic notifies about.  The 
options in this frame vary so that you can select items that are appropriate for the plug-in 
and view.  Select an item type (workgroup, workflow, campaign, agent, etc.) in this frame 
to enable selection of individual items (workgroups, workflows, campaigns, agents, etc).    

Selected Items list 

This control lists items that you can select to monitor.  Depending upon the item type, the 
names of workgroups, workflows, campaigns, agents, etc. are listed.  Check the items 
that you wish to set alerts on. 

Add Range button 

Opens the Alert Properties dialog (p. 91) , so that you can define a range of "From" and 
"To" values for the statistic, and notification details.  To complete the Alert Properties 
dialog, select a range of values for the alert, and the manner in which the alert will notify 
(by changing colors in the display, playing a sound, sending an Email, or invoking a 
handler). 

Close button 

Press this button to dismiss the Add Multiple Alerts dialog. 

Help button 

Opens this help topic. 

Related Topics 

 Add Multiple Alerts (p. 66)  

 Manage Alerts (p. 64)  
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Add / Remove Queue Columns dialog 

 

This dialog adds, removes, and reorders columns displayed in a Queue Monitor control (p. 34).  
It appears when a user right-clicks in a Queue Monitor control (p. 34) , and selects "Columns…" 
from the context menu.   

Available list 

This list contains the names of columns that can be added to the list of columns selected 
for display.  To display a column, select it in the Available list, press Add, and then press 
OK to close the dialog. 

Selected list 

This columns in this list will appear in the Queue Monitor control once the OK button is 
pressed.  The left-to-right display order of columns is determined by the Up/Down order of 
entries in this list.  Columns can be reordered using Up/Down buttons. 

Up/Down buttons 

These buttons reorder items in the Selected list, which sets the display order of columns in 
the Queue Monitor control. 

Custom Columns button 

Press this button if you want to add or remove custom columns to the Available columns 
list.  It opens the Manage Custom Columns dialog (p. 119). 

OK button 

Closes the dialog and applies changes. 

Cancel button 

Closes the dialog without applying changes. 

Help button 

Opens this help topic. 

Related Topics 

 Add custom columns to a Queue Monitor Control (p. 40)  
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 Use Queue Monitor Controls (p. 34)  
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Alert Properties dialog 
The Alert Properties dialog sets a range of values for the alert, and defines the manner in which 
the alert will notify (by changing colors in the display, playing a sound, sending an Email, or 
invoking a handler).   

The dialog title is the name of the statistic selected in the Edit Alerts (p. 106)  dialog. 

 

To configure the alert, set options on each tab page as needed.  If you configure more than one 
notification type (e.g.: Email and sound, for example), both notifications are triggered when the 
alert is active. 

 The Range (p. 92)  page defines upper and lower bounds for the alert, and sets the icon 
used to indicate that the alert is active. 

 The Display (p. 93)  page sets the appearance of text when the alert is active. 

 The Sound (p. 94)  page sets wave audio sounds to play when the value of the statistic 
enters or exits the range, or is within range. 

 The Email (p. 96)  page defines recipients of Email notifications sent when the value of the 
statistic enters or exits the range, or when the value of a statistic changes. 

 The Supervisor Message (p. 98)  page defines Supervisor messages that can be sent by 
an Alert. 

 The Custom Handler (p. 100)  page sets options used to invoke a handler. 

Related Topics 

 Alert Properties Dialog (p. 91)  

 Manage Alerts (p. 64)  
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Range page 

 

Options on this page establish "from" and "to" boundaries for the alert, and the icon color to 
display when the alert is active. 

Icon 

Selects a colored icon to display when the alert appears. 

Lower Bound 

Sets the lower boundary to include in the alert range. For example, if you set an alert 
to notify you when the total agents available to take ACD calls falls between 10 to 50, 
the lower bound would be 10. 

Upper Bound 

Sets the upper boundary to include in the alert range. For example, if you set an alert 
to notify you when the total agents available to take ACD calls falls between 10 to 50, 
the upper bound would be 50. 

OK button 

Closes the dialog and puts alert properties into effect. 

Cancel button 

Closes the dialog without setting alert properties. 

Help button 

Opens this help topic. 

Related Topics 

 Alert Properties Dialog (p. 91)  

 Manage Alerts (p. 64)  
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Display page 

 

Options on the this page control the appearance of statistic text when the alert is active. 

Text Color 

Sets the foreground color to display when the alert is active.  The default color is 
Automatic, meaning that the Windows' foreground text color will be used.    

Background Color 

Sets the background color to display when the alert is active.  The default color is 
Automatic, meaning that the Windows' background text color will be used.    

Font Weight 

Sets the font weight to Bold, Default, or Normal, to control the appearance of text 
when the alert is active.   

OK button 

Closes the dialog and puts alert properties into effect. 

Cancel button 

Closes the dialog without setting alert properties. 

Help button 

Opens this help topic. 

Related Topics 

 Alert Properties Dialog (p. 91)  

 Manage Alerts (p. 64)  
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Sound page 

 

Options on this page set wave audio sounds to play when the value of the statistic enters or 
exits the range, or is within range. 

Play on Entering Range checkbox 

Check this box to specify the path and filename of a wave audio file to play when the 
value of the statistic enters the range defined for the alert.  You can type a fully 
qualified path directly into the field, or press the … button to select a wave audio file 
using a File Open dialog.  The adjacent "speaker" button previews the selected wave 
file.  If you type an invalid entry in the field, Supervisor will display a message when it 
validates the entry: 

 

Play on Exiting Range checkbox 

Check this box to specify the path and filename of a wave audio file to play when the 
value of the statistic exits the range defined for the alert.  You can type a fully 
qualified path directly into the field, or press the … button to select a wave audio file 
using a File Open dialog.  The adjacent "speaker" button previews the selected wave 
file. 

Play while in Range checkbox 

Check this box to specify the path and filename of a wave audio file to play when the 
value of the statistic is within the range defined for the alert.  You can type a fully 
qualified path directly into the field, or press the … button to select a wave audio file 
using a File Open dialog.  The adjacent "speaker" button previews the selected sound 
file. 

Use this feature with care, since the audio file will play repeatedly while the alert is 
active.   

OK button 

Closes the dialog and puts alert properties into effect. 
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Cancel button 

Closes the dialog without setting alert properties. 

Help button 

Opens this help topic. 

Related Topics 

 Alert Properties Dialog (p. 91)  

 Manage Alerts (p. 64)  
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Email page 

 

Options on this page send Email messages when the value of the statistic enters or exits the 
range, or when the value of a statistic changes.   

To set up email alerts, you must have permission granted by your administrator.  See 
allow alerts to send emails or trigger a handler (p. 15).  Since it is possible to create an 
Email alert that does not provide an Email address, the underlying handler will not fire if 
the Email address is left blank. In releases before IC 2.4, no address checking was 
performed, which could caused an assertion in PostOfficeServer. 

Send Email on Entering Range checkbox 

Check this box to send an Email when the value of the statistic enters the range 
defined for the alert.  

Send Email on Exiting Range checkbox 

Check this box to send an Email when the value of the statistic exits the range defined 
for the alert.  

Send Email when this Alert Changes checkbox 

Sends an Email when anything defined for the alert changes, including changes to the 
icon, range, sound, notification selections, or specified values within the alert. 

Send an Email anytime the observed value changes and is in range 

Sends an Email every time that a value within the range of the alert changes. Use this 
option carefully, since it can potentially generate many messages. 

Email Addresses 

This field prompts for Email addresses.  To send email notifications to multiple email 
addresses, separate each email address by a comma. 

OK button 

Closes the dialog and puts alert properties into effect. 

Cancel button 

Closes the dialog without setting alert properties. 

Help button 

Opens this help topic. 

When you set up an email notification, you may notice that fields on the Custom Handler 
tab have been modified. In Interaction Supervisor, an email notification is considered a 
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custom alert where the customization is already provided.  Therefore, when an email 
notification is defined, Interaction Supervisor automatically completes information on the 
Custom Handler tab. However, setting up custom alerts won’t have any effect on an 
email notification (i.e. an email notification is a custom alert handler, but a custom alert 
hander is not necessarily an email notification). 

Related Topics 

 Alert Properties Dialog (p. 91)  

 Manage Alerts (p. 64)  
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Supervisor Message page 

 

This page configures an alert to send a Supervisor message to an IC Client user.  The 
message will be sent while the alert is in range, rather than "on entering range" or "on 
exiting range".  The dialog is similar to the Create Supervisor Message dialog, with the 
exception that there is no expiration field. 

Send Message While Alerting checkbox 

When this option is checked, controls on this dialog that configure a Supervisor 
message are enabled.  When you uncheck this box, the message part of the alert is 
removed without removing the entire alert. and the alert will stop sending messages.  
The alert will hold the message text and other options, so that you can turn it back on 
later by re-checking this option.  

To… button 

Press this button to select destination user(s).  The names of selected IC users will 
appear in the read-only field to the right of the button. 

Message details frame 

Send as Desktop Pop-up 

This option determines whether or not the message will be displayed in a pop-up 
message box, or in the client notification area at the bottom of the client window.  
Checking this option displays the message in its own pop-up window. 

Message Text 

This box prompts for the text of the message that will be sent in response to the Alert. 

Client Display Options frame 

Sound checkbox 

Check this box to play a sound when the message arrives. 

Sound File drop list 

When this drop list is enabled, you can choose a sound to play. 

Speaker button 

Plays the selected sound. 

Icon checkbox 

Check this box to associate an icon with the message.  
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Icon browse button 

Push this button to browse for icon (.ico) files.  The selected icon will appear on the 
button face. 

URL Checkbox 

Check this box when you want the message to send a URL to the recipient.  It enables 
the URL field so that a URL may be typed in. 

Related Topics 

 Alert Properties Dialog (p. 91)  

 Manage Alerts (p. 64)  

 Send Messages to Interaction Client users (p. 76)   
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Custom Handler page 

 

Use the options on this page to invoke a handler when the alert is active. 

Initiate handler on Entering range checkbox 

Initiates a handler when the statistical item enters the specified alert range. "Entering" 
the range is independent from which direction it approaches the alert range. 

Initiate handler on Exiting range checkbox 

Initiates a handler when the statistical item exits the specified alert range. "Exiting" 
the range is independent from which direction leaves the alert range. 

Initiate handler when this Alert changes 

Initiates the handler when anything defined for the alert changes, including changes to 
the icon, range, sound, notification selections, or specified values within the alert. 

Initiate the handler anytime the observed value changes and is in range 

Initiates the handler when the observed value of the alert changes, and is within 
range.  Use this option carefully since it could potentially initiate many handler 
instances. 

User data passed to handler 

Any information that should be passed to the handler as payload. 

OK button 

Closes the dialog and puts alert properties into effect. 

Cancel button 

Closes the dialog without setting alert properties. 

Help button 

Opens this help topic. 

Related Topics 

 Alert Properties Dialog (p. 91)  

 Manage Alerts (p. 64)  
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Change Caption Selection dialog 

 

This dialog appears when the user presses a toolbar button or selects "Change [item]" from a 
custom menu to change the item that a view reports on.  For example, you might select a 
different workgroup, workflow, or agent, depending upon the plug-in and view.  The purpose of 
this dialog is to allow one item to be selected for display by the view. 

Item list 

This list contains the names of items that may be selected for display.  This is normally a 
workgroup, but could be the names of workflows, campaigns, agents, etc. 

OK button 

Closes the dialog and changes the view selection. 

Cancel button 

Closes the dialog without changing the view. 

Related Topics 

 Change the Caption Selection (p. 31)  

 Manage Views (p. 29)  
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Change Station dialog 

 

The Change Station command allows you to switch to a different workstation, without restarting 
Interaction Supervisor.  Please note that Supervisor does not "Log in" to a station.  A user that 
runs Supervisor will not be shown as logged in to that station in Interaction Administrator or 
Interaction client.  The system makes no association between user and station.  The station is 
used only to specify where the audio will be played for call monitoring.   

Incoming calls will still be routed based on the where a user has "logged in" via Interaction 
client or the telephony user interface (TUI).  For example, an Administrator might retrieve and 
place calls on one station and perform supervisory monitoring on another station.  Of course 
they can also do both from the same station if they choose. 

To change station, follow these steps: 

1. Pull down the File menu and select Change Station. 

2. Enter a different station name in the New Station field.   

This dialog doesn't offer a Cancel button, but you can close this dialog without entering 
a different station, press the close box in the top right corner of the title bar. 

3. Press OK. 

Related Topics 

 Commands (p. 82)  

 Dialogs (p. 84)  
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Create Supervisor Message dialog 

 

Use this dialog to compose and send a new Supervisor message.  It appears when the Create 
Message (p. 78)  command is invoked.  For background information, see Send Messages to 
Interaction Client Users (p. 76). 

To… button 

Press this button to select Users or Workgroups that should receive this message. It opens 
the Recipients (p. 122)  dialog. The destinations you select will appear in the read-only 
field to the right of the button. 

Message details frame 

Send as Desktop Pop-up 

This option determines whether or not the message will be displayed in a pop-up message 
box, or in the client notification area at the bottom of the client window.   

Message Text 

This box prompts for the text of the message that will be sent. 

Expire message after n minutes 

Sets a timer that automatically removes the message from the client after a configurable 
number of minutes. 

Message Options frame 

Sound checkbox 

Check this box to play a sound when the message arrives. 

Sound File drop list 

When this drop list is enabled, you can choose a sound to play. 

Speaker button 

Plays the selected sound. 

Icon checkbox 

Check this box to associate an icon with the message.  
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Icon browse button 

Push this button to browse for icon (.ico) files.  The selected icon will appear on the button 
face. 

URL Checkbox 

Check this box when you want the message to send a URL to the recipient.  It enables the 
URL field so that a URL may be typed in. 

Send button 

Sends the message and closes the dialog. 

Cancel button 

Closes the dialog without sending the message. 

Help button 

Opens this help topic. 

Related Topics 

 Send Messages to Interaction Client Users (p. 76)  
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Custom Toolbar Name dialog 

 

This dialog appears when a new toolbar is added from the Toolbar Options (p. 128)  dialog. 

Toolbar name 

Type a short descriptive name for the custom toolbar in this field. 

OK button 

Closes the dialog and creates a new toolbar with the name specified. 

Cancel button 

Closes the dialog without creating a new toolbar. 

Help button 

Opens this help topic. 

Related Topics 

 Toolbar Options dialog (p. 128)  

 Manage Toolbars (p. 74)  
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Edit Alerts dialog 
The Edit Alerts dialog selects a statistic to base an alert on.  This dialog presents different 
options in accordance with data items used by the active view.   For example, the Edit Alerts 
dialog for a System Statistic is simple: 

 

Conversely, selecting a statistic for Interaction Dialer's "Agent Detail" view is more complicated, 
since you must also select Workflow, Campaign, Site, and Agent information:   

 

The point to remember is that this dialog, regardless of its appearance, has one purpose—to 
select the statistic to base an alert on.  Once you have selected a statistic, the next step is to 
define its range of "From" and "To" values, icon colors, and notification details.   

Add Range button 

Opens the Alert Properties (p. 91)  dialog, which sets a range of values for the alert, and 
defines the manner in which the alert will notify (by changing colors in the display, playing 
a sound, sending an Email, or invoking a handler).   

Edit Range button 

Edits Alert Properties for the selected statistic.  
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Remove Range button 

Removes selected alerts for this statistic.  When you press this button, the selected items 
are removed immediately—you are not prompted to confirm the operation. 

Close button 

Closes the dialog and puts the alert into effect. 

Help button 

Opens this help topic. 

Related Topics 

 Manage Alerts (p. 64)  
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Filter Settings dialog 

 

This dialog appears when the Filter Settings toolbar button ( ) is pressed from the Manage 
Alerts (p. 116)  dialog.  It displays settings that affect the filtering of alerts based upon text 
entered in the Look For text box. 

Match Case 

When checked, the selection of alerts will be case-sensitive to match the case specified in 
the Look For text box.   

Include in Filter 

The settings in this group determine which data elements are compared to the search 
criteria entered in the Look For text box.  The elements that can be evaluated are: 

Statistic Name—name of the statistic. 

Attributes—data items evaluated by the statistic. The attributes required for each statistic 
are defined by the plug-in.   

Sound Settings—evaluate sound filename (Play on Entering, Exiting, Play While). 

Email Settings—evaluate Email address associated with each alert. 

Handler Settings—evaluate handler settings. 

OK button 

Applies selected filter settings and closes the dialog.  Changes go into effect when the 

Filter Now button ( ) is pressed. 

Cancel button 

Closes the dialog without changing settings. 

Help button 

Opens this help topic. 

Related Topics 

 Manage Alerts dialog (p. 116)  
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Graph Configuration dialog 
The Graph Configuration dialog (p. 109)  configures all aspects of a graph, including its type, 
grouping, period, colors, title, axes, and legends.  Tabs on this dialog place these options at 
your fingertips. 

General page 

 

Options on the General page manage the appearance of the graph: 

Graph Type buttons 

These options change the graph type to line, vertical bar, or horizontal bar. 

Data Grouping radio buttons 

These radio buttons control the manner in which statistics are aggregated.  The 
specific grouping options vary by plug-in and view. 

Line Graph Period list box 

Specifies the length of time for which statistics should be graphed for a line chart. 

Background Color list box 

Selects the background color of the graph. 

Grid Color list box 

Selects the color of lines in the graph. 
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Title page 

 

Options on the Title page manage the graph's title, font, size and color. 

Show Title checkbox 

When checked, displays the title of the graph. 

Title Type radio buttons 

Select Default to use a default title, or select Custom to define a custom title. 

Custom Title field 

When Title Type is Custom, you can enter a custom graph title in this field.  Otherwise 
this field is disabled and is not used. 

Font list box 

Selects the title font. 

Size list box. 

Selects the title font size. 

Color list box. 

Selects the title color. 
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Axes page 

 

Options on this page manage the display of labels along the axes of the graph. 

Show Labels checkbox 

This option is checked by default, so that labels appear along the axes of the graph. 

Label color list box 

Selects the color of axes label text. 

Legend page 

 

Options on the Legend page affect the display of legends. 

Show Legend checkbox 

Controls whether or not the graph has a legend. 
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Legend Settings buttons 

These buttons position the legend left, below, or to the right of the graph. 

Show values in Legend check box 

Values appear in the legend when this option is checked. 

OK button 

Closes the dialog and applies changes to the graph. 

Cancel button 

Closes the dialog without applying changes to the graph. 

Apply button 

Applies changes to the graph without closing the dialog.  This allows you to preview 
the result of a configuration change. 

Help button 

Opens this help topic.  

Related Topics 

 Open the Graph Configuration dialog (p. 56)  

 Manage Graphs (p. 53)  



 

Interaction Supervisor User Guide Page 113 of 139 

Interaction Supervisor Login dialog 

 

This dialog prompts for information used to authenticate the user.   

Interaction Supervisor can be started using command-line arguments (p. 23)  that eliminate 
the display of this prompt.  See Start Interaction Supervisor (p. 22)  for details. 

User Name field 

Enter a valid Interaction Center User Name in this field. 

Password field 

Type the password that corresponds to the user name entry. 

Station field 

The IC station name defined in Interaction Administrator for the current user.  

Server field 

Name of this user's IC server. 

OK button 

Closes the dialog and attempts to authenticate the user.  If authentication fails, 
Supervisor redisplays the Login dialog, so that you can correct a typing error or login 
using a different ID.    

Cancel button 

Closes the dialog without attempting to authenticate the user. 

Related Topics 

 Start Interaction Supervisor (p. 22)  
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Manage Agent Activations dialog 
The IC's Agent Activation feature dynamically manages which workgroups an agent will receive 
calls for.  Agents can be deactivated from a workgroup while still maintaining membership in 
the workgroup. Deactivated agents do not receive calls for that workgroup.  This helps 
supervisors to effectively and flexibly manage agents without having to change workgroup 
membership, and helps many organizations better meet service-level goals. 

The Manage Agent Activations dialog allows a Supervisor to see which workgroups an individual 
user is activated on, and then adjust their activation settings as appropriate.  It lists the 
workgroups that an agent belongs to, and allows the agent to be set as active or inactive within 
each workgroup.  The Supervisor must have the right (assigned in Interaction Administrator) to 
activate or deactivate members of the workgroup—note the padlock icon in the figure below.  It 
indicates that the Supervisor does not have rights to activate or deactivate members of the 
Sales workgroup.    

 

The availability of an agent to receive calls for a particular workgroup is determined by whether 
or not he or she is in an active or inactive state within that workgroup. Agents will only receive 
calls for workgroups in which they are active. An agent is eligible to receive an ACD call if he or 
she: 

 Is logged into Interaction Client  
 Sets his or her workgroup state to Active 
 Sets his or her status to Available  

Workgroup activation allows an agent to be a member of multiple workgroups, while at the 
same time allowing the supervisor to specify the workgroup queues for which he or she will 
take calls. 

Member of list 

This list contains the names of workgroups that the agent is not active in.  The Agent will 
not receive calls for workgroups in this list. 

Activated on list 

This list contains workgroups that the agent is active in.  The agent will receive calls for 
workgroups in this list. 

Add button 

Adds selected workgroups to the Activated on list, so that the agent will receive calls for 
those workgroups. 
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Remove button 

Moves selected workgroups from the Activated on list to the Member of list so that the 
agent will no longer receive calls for those workgroups. 

Ok button 

Closes the dialog and places workgroup activation settings into effect. 

Cancel button 

Closes the dialog without applying changes. 

Help button 

Opens this help topic. 

Related Topics 

 Change an Agent's workgroup activation (p. 75)  
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Manage Alerts dialog 

 

This dialog lists all alerts and allows any alert to be edited or removed.  It appears when 
Manage Alerts is selected from the View menu.  The data columns in the list are sortable, but 
are not configurable.  You cannot add or remove columns. 

Category drop list 

Alerts can be filtered by category.  An alert category is a logical grouping of statistics that 
have the same Stat Watcher attributes associated with them.  Any number of alert 
categories can be defined by a supervisor plug-in.  This drop list allows a specific alert 
category to be selected.  Two additional selections are available: [All Alerts] and 
[Overview]. 

[All Alerts] 

When [All Alerts] is selected, the list control displays each alert category and the 
number of alerts configured for each category.  The columns displayed are: 

Statistic—The stat that the alert is based on. 
Category—The category of alerts. 
Attributes—One column is created for each attribute required by the statistic. The 
attributes required for each statistic are defined by the plug-in.   
Range—The condition under which the alert is active. 
Display—The appearance of text when the alert is active. 
Sound—Indicates that a sound is configured to play when the alert is active. 
E-Mail—Indicates that an Email is configured to be send when the alert is active. 
Handler—The number of alerts configured that will cause a handler to fire. 

[Overview] 

This selection displays counts for each alert category and for [All Alerts].  The 
columns displayed are:  

Category—The category of alerts. 
Total—The total number of alert configured for the category. 
Red—The number of red alerts configured for the category. 
Yellow—Then number of yellow alerts configured for the category. 
Green—Then number of green alerts configured for the category. 
Sound—The number of alerts configured that will cause the system to play a sound. 
E-Mail—The number of alerts configured that will cause IC to send an Email Alert. 
Handler—The number of alerts configured that will cause a handler to fire. 

Any Category selection 

When a category name is selected, the control lists all alerts associated with that 
category.  The columns displayed are: 

Statistic—The stat that the alert is based on. 
Attributes—One column is created for each attribute required by the statistic.   
Range—The condition under which the alert is active. 
Display—The appearance of text when the alert is active. 
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Sound—Indicates that a sound is configured to play when the alert is active. 
E-Mail—Indicates that an Email is configured to be send when the alert is active. 
Handler—The number of alerts configured that will cause a handler to fire. 

Overview button ( ) 

Pressing this button is equivalent to selecting [Overview] from the Category drop list.  It 
tells the list control to display counts for each alert category and for [All Alerts].   

Open Category button ( ) 

Alerts can be broken into categories; for example, Workgroup, Agent, Queue, and 
Workflow are category codes.  This button is only active when a category is selected in the 
overview.  It opens the selected alert category, which causes the overview to display each 
category and how many alerts are in each category, so that the user may drill into that 
category to see the actual alerts.  The Open Overview command is also available from the 
context menu that appears when a category is right-clicked.   

Edit Alert button ( ) 

To edit the selected alert, press this button or double-click a row in the list.  This opens 
the Alert Properties (p. 91)  dialog, so that you can modify the alert. 

Remove Alert(s) button ( ) 

Removes selected alerts.  The operation must be confirmed before alerts are actually 
removed. If you press No, alerts are not removed. 

 

Removal of alerts can be performed on a multiple selections, or even from the [Overview] 
to remove entire categories of alerts at once. However, only one alert can be edited at a 
time. 

Look For text box 

The text box works in combination with Filter Now, Clear Filter, and Filter Settings 
buttons.  The string that you enter in this list is used to select a subset of listed alerts.  To 

filter the list, enter a search string in the text box and then press the Filter Now ( ) 
button. The list will update to display only those alerts that match the search string. 

 Filter Now—selects alerts that match the string entered in the Look For text box. 

 Clear Filter—removes filter criteria so that all alerts appear in the list. 

 Filter Settings—opens the Filter Settings (p. 108)  dialog.   

Context menu 

Right-clicking a row displays context menu commands. 

 

Open Overview tells the list control to display counts for each alert category and for [All 
Alerts].   
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Open Category is available in [Overview] display mode.  This command tells the list 
control to display only alerts that match the category of the selection. 

Edit Alert opens an alert for editing. 

Remove Alert(s) removes alerts from the system. 

Related Topics 

 Use the Manage Alerts dialog (p. 73)  

 Manage Alerts (p. 64)  
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Manage Custom Columns dialog 

 

This dialog appears when the Custom Columns button is pressed from the Add / Remove Queue 
Columns dialog (p. 89).  It adds or removes custom columns to the set of columns that can be 
displayed by a Queue Monitor control. 

Add button 

Opens the Add Custom Column dialog (p. 87) , so that you can define a custom column 
based upon a single queue attribute, or custom attribute.   

Remove button 

Removes the selected column from the list of Custom Columns. 

OK button 

Closes the dialog and applies changes made. 

Help button 

Opens this help topic. 

Related Topics 

 Add custom columns to a Queue Monitor Control (p. 40)  

 Use Queue Monitor Controls (p. 34)  
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New View dialog 
This dialog box adds a new view (p. 8)  to the workspace.  It  appears when you press CTRL + 

N, select New… from the File menu, or click the New button ( ) on the Interaction Supervisor 
toolbar.   

 

Name of Plug-in tabs 

Each loaded plug-in has its own tab page on this dialog, which lists views that you can add 
to the workspace.  The All tab lists views for all loaded plug-ins, prefixed by plug-in name. 

Views in plug-in list 

This list displays the name of each view and its icon.  The icons in this list are small or 
large, depending upon whether the List or Large Icons button is pressed.  Each item in 
this list represents a view that you can add to the workspace. 

View Preview image 

This pane displays an image of the selected view. 

View Description 

This pane displays a short description of the selected view. 

Large Icons button 

This button is pressed by default. It displays the list of views using large icons. 

List button 

This button displays the list of views using small icons. 

OK button 

Closes the dialog and creates the selected view. 

Cancel button 

Closes the dialog without creating a new view. 

Help button 

Opens this help topic. 

Related Topics 

 Add a view to the workspace (p. 30)  

 Manage Views (p. 29)  

 View, Menu, and Toolbar Integration (p. 10)  
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Plug-in Information dialog 

 

This dialog displays the name of each plug-in that Supervisor detects at startup, and indicates 
whether or not you have access rights to a plug-in and its views.  This dialog appears when 
Plug-In Info is selected from the Help menu. 

Plug-in/View Name column 

This column lists the name of each plug-in that Supervisor detected at startup.  The row 
can be expanded to reveal the names of views. 

License column 

This column indicates whether or not your station has rights to use the plug-in or view.  
Yes indicates that you do, No indicates that you do not, and Partial (at the plug-in level) 
indicates that some views are not available to you.    

In this release, access to individual views cannot be restricted.  If you have rights to 
the plug-in, you may access all of its views.  More granular control over view access 
may be provided in a future release. 

Filename column 

Name of the plug-in DLL. 

File version 

Version number of the plug-in DLL. 

OK button 

Closes the dialog. 

Help button 

Opens this help topic. 

Related Topics 

 Display rights assigned to you (p. 17)  

 Required access rights (p. 13)  

 Recommended access rights (p. 15)  
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Recipients dialog 

 

Use this dialog to specify where a Supervisor message should be sent.  It appears when the To 
button is pressed from the Create Supervisor Message dialog. 

Show drop list 

This control displays a list of Workgroups, User names, or both in the Available drop list. 

Available list box 

Select the names of Users or Workgroups from this list.  Then press Add to move them to 
the Selected list. 

Selected list box 

This list box contains the names of Users or Workgroups that will receive the message. 

Add button 

Adds items selected in the Available list box to the Selected list box, so that they will 
receive the message. 

Remove button 

Adds items selected in the Selected list box to the Available list box, so that they will not 
be sent the message. 

OK button 

Closes this dialog, saving the selections that you have made. 

Cancel button 

Closes this dialog without saving selections. 

Help button 

Opens this help topic. 

Related Topics 

 Create Supervisor Message dialog (p. 103)  

 Send Messages to Interaction Client users (p. 76)   
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Rename View dialog 

 

This dialog appears when you rename a view using a method documented in the rename a view 
(p. 33)  procedure. 

Name field 

Enter a descriptive name for the view in this field.  This name will appear on the view's tab 
page. 

OK button 

Closes the dialog and applies the new name to the view. 

Cancel button 

Closes the dialog without applying a new name to the view. 

Help button 

Opens this help topic. 

Related Topics 

 Rename a View (p. 33)  

 Manage Views (p. 29)  
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Statistic Selection dialog 
This dialog selects statistics to include or exclude from a view.  Its appearance varies by plug-in 
and view.  The dialog may offer supplemental tabs to organize statistics by category.   

 

In general, Statistic Selection dialogs have several features in common: 

 They provide two lists—one that displays data items selected for display in the view, and 
another that list items that you can add to the view.    

 You can press an Add button to move selected items from the Available list to the list 
of items selected for display.   

 Conversely, you can press a Remove button to moves selected items to the Available 
list.  This prevents them from appearing in the view. 

 Up and Down buttons change the order of items in the Selected list, and control the 
display order of items in the view. 

 If the view provides statistics for multiple view categories, controls may appear on tab 
pages.   

OK button 
Applies selections and closes the Statistic Selection dialog. 

Cancel button 
Closes the dialog without applying changes. 

Supplemental Category Tabs 
Supplemental tabs on the dialog, if any, are implemented by the plug-in and serve to 
categorize statistics so that you can locate them more easily.  

 

You may need to refer to help for a plug-in module for more information about the statistics 
that you can select. 
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Related Topics 

 Add or remove statistics from a tabular view (p. 32)  

 Add or remove statistics from a graph view (p. 57)  

 Manage Views (p. 29)  



 

Interaction Supervisor User Guide Page 126 of 139 

View Supervisor Messages dialog 

 

Interaction Supervisor automatically saves messages on the IC server until they are deleted or 
expire.  This dialog lists each message and the options selected when the message was 
composed or last sent.  Use this dialog to add, edit, or remove messages. 

Supervisors can use this dialog to review all messages in the system, to edit and remove 
messages, as well as create new ones.  Pressing Add or Edit opens the Create Supervisor 
Message (p. 103)  dialog, unless it is an alert message, in which case the proper Edit Alert 
dialog will pop opened to the Messaging tab (p. 98).   

This dialog appears when the  toolbar button is pressed, or when the View > Supervisor 
Messages command is invoked.  

Columns listed 

Icon column 

This column displays the icon associated with each message. 

To column 

This column lists the recipients of each message. 

Message column 

This column lists the body text of each message. 

Expiration column 

This column displays the amount of time that the message will be held in the client before 
it is automatically removed.  If an expiration time was not set, zero is displayed to 
indicate that the message will be held until the user deletes or, or until it is deleted by an 
Administrator using this dialog.  When a message expires, it disappears from this list. 

Sound column 

This column displays the name of the sound file that plays when the message is received. 

URL column 

If a Universal Resource Locator (e.g. a web address) is associated with the message, it is 
displayed here. 

Add button 

Composes a new Supervisor message (p. 78). 

Remove button 

Removes a saved message (p. 80).  Use this feature carefully, since you are not asked to 
confirm the removal operation. 

Edit button 

Opens the message so that you can reuse (p. 79)  it. 

OK button 

Closes the View Supervisor Messages dialog. 
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Help button 

Opens this help topic. 

Related Topics 

 Send Messages to Interaction Client users (p. 76)  

 Allow Supervisor Message Creation (p. 15)  

 Supervisor Alert Message Page (p. 98)   
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Toolbar Options dialog 
The Toolbar Options dialog appears when the View > Toolbars command is issued.  This dialog 
allows users to customize toolbars by dragging and dropping buttons onto an existing toolbar.    

Toolbars tab 

Options on its Toolbars tab determine which toolbars are visible, and their visual appearance.   

 

Toolbars list 

This list displays the names of available toolbars, including toolbars added by plug-ins.  
Toolbars that are checked in this list are displayed in the user interface.   

Show Tooltips checkbox 

When this option is checked, short descriptions of each toolbar function are displayed 
when the mouse hovers over a button.  Unchecking this option disables display of Tooltips. 

Cool Look checkbox 

This option determines whether all toolbar buttons have button borders.  When checked, 
buttons are drawn without borders. 

 

Large Buttons checkbox 

Displays large toolbar icons if the plug-in provides them.  This option is disabled when 
large icons are not available. 
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New button 

Creates a custom toolbar that you can position anywhere on the screen.   Type a short 
descriptive name and press OK. 

 

To add buttons to this toolbar, select the Toolbar Buttons tab (p. 130).  Then drag and 
drop toolbar icons to your custom toolbar.  

Reset button 

Resets the selected toolbar to its default settings.  This removes icons that added from 
other toolbars. 

Delete button 

If the selected toolbar is a custom toolbar, the caption of the Reset button is changed to 
Delete, so that you can remove a custom toolbar.  

Toolbar Name field 

This field displays the name of the toolbar.  It is read-only unless a custom toolbar is 
selected in the list.  You can rename a custom toolbar by editing its name in this field. 

OK button 

Closes the Toolbar Options dialog and puts changes into effect. 

Cancel button 

Closes the Toolbar Options dialog without putting changes into effect. 

Help button 

Opens this help topic. 

Related Topics 

 Toolbar Options dialog (Buttons page) (p. 130)  

 Manage Toolbars (p. 74)  
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Toolbar Options dialog (Buttons page) 

 

This page of the Toolbar Options dialog allows toolbar buttons to be dragged and dropped 
between toolbars.   

Categories list 

This list displays the names of available toolbars.  Buttons are displayed for the toolbar 
that is selected in this list.   

Buttons frame 

This frame contains buttons for the selected toolbar.  These buttons can be dragged and 
dropped to custom or built-in toolbars. 

Description 

Short, read-only description of the selected toolbar button. 

OK button 

Closes the Toolbar Options dialog and puts changes into effect. 

Cancel button 

Closes the Toolbar Options dialog without putting changes into effect. 

Help button 

Opens this help topic. 

Related Topics 

 Toolbar Options dialog (p. 128)  

 Manage Toolbars (p. 74)  
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Tray Icon 
At startup (p. 22) , Interaction Supervisor creates a tray icon that indicates whether any alerts 
are active.  Alerts notify when a statistic is in or out of a chosen range, based on statistical 
items or values on the IC Server.  If there are no active alerts, the tray icon is gray.   

 

Once you set an alert (p. 65)  and it becomes active, the tray icon changes to the color 
assigned to the alert.  If multiple alerts are active, the color of the worst-case alert is displayed.  
The tray icon provides an indicator of alerts when Interaction Supervisor is minimized.  The tray 
icon also provides a context menu.    

 

These commands are available when the tray icon is right-clicked: 

Help 

Launches Interaction Supervisor online help. 

Show Active Alerts 

Opens the Active Alerts (p. 85)  dialog box.  It displays the status of the current alerts you 
have set. 

Show Supervisor 

Displays Interaction Supervisor as the active window with focus. 

Exit Supervisor 

Closes Interaction Supervisor. 

Related Topics 

 Manage Alerts (p. 64)  
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Glossary 

To use Interaction Supervisor effectively, it helps to understand the terms listed on this page. 

Abandoned Call 

An abandoned inbound call is a call that was disconnected before an agent connection could be 
established.  These are usually calls that end when a caller decides not to wait for an agent.  However, 
abandonment applies to outbound calls also. An abandoned outbound call is a call answered by a live 
contact that was disconnected before an agent could communicate with the party.  For example, 
Interaction Dialer may abandon calls if the pace of outbound dialing is too aggressive.  By default, 
Interaction Dialer disconnects calls when no agents are available.  In most cases, the percentage of 
abandoned calls is extremely low compared to the total volume of calls.  But if pace is set too high, the 
Outbound Server places additional calls, raising the possibility that some calls will be abandoned.  
Abandoned calls are sometimes called nuisance calls, since most people find it irritating to be hung up on.  
Nuisance calls can be frightening to older individuals, especially those living alone.  Consequently, it is a 
good idea to monitor the number of abandoned calls, so that the pace of outbound calling can be adjusted 
to keep nuisance calls to a minimum.    

Alert 

An Alert notifies when a statistic is in or out of a user-defined range, based on statistical items or values 
on the IC Server.  When an alert becomes active, it can play a sound, change the color of an icon, send 
Email, or initiate a handler. 

ANI 

ANI stands for Automatic Number Identification.  ANI is often called Caller ID. All phone calls contain the 
numbers of the dialing phone. Those numbers can be displayed on a screen or used by the receiving 
phone system to tell the call recipient useful information. 

Call Attribute 

A call attribute is a piece of information about an object that travels with it throughout the Interaction 
Center.   For example, one standard attribute of a call object is the telephone number of the person who 
placed the call.  A call object can have as many attributes as are needed.  Attributes stay with a call until 
it is disconnected.  The IC supports application programming interfaces (API's) that provide access to call 
object attributes.  Dynamic Data Exchange (DDE) is commonly used to accomplish this, as is the 
Interaction Client COM API.  Attributes typically store information that is passed to a database or a third-
party application.  For example, the IC can be set up to "pop" a database application when an incoming 
call arrives at an agent's workstation.  For more information about DDE and other APIs, see the System 
APIs section of the master documentation library on your IC server.  Likewise, the Interaction Attributes 
Reference Guide (attrib.chm) in the System APIs section of the documentation library describes attribute 
names that are reserved by IC.   If you assign data to a standard IC attribute, you could potentially affect 
the execution of a handler.  The Object Attributes Reference Guide identifies attributes whose value you 
should not change. 

Customer Interaction Center (CIC) 

The Customer Interaction Center (CIC) is designed for sophisticated contact centers managing inbound, 
outbound, or blended interactions. CIC provides skills-based routing not only for telephone interactions, 
but faxes, Emails, text chats, Web call-back requests, and voice over IP calls. CIC can support up to 
several hundred agents per site, and offers optional pre and post-call routing across multiple locations. 
And it makes screen popping a breeze, with easy interfaces to products from leading CRM vendors such as 
Siebel, Pivotal, Onyx, Peoplesoft, and many more. 

DNIS 

Dialed Number Identification Service (DNIS) is a feature of digital T-1 and ISDN lines (like 800 and 900 
lines) that provides the number the caller dialed.  DNIS is a system by which IC can determine what 
number a caller dialed.  

Enterprise Interaction Center (EIC) 

The Enterprise Interaction Center (EIC) is targeted at the needs of businesses, dotcoms, not-for-profits, 
etc.  EIC can serve the 20-person startup just as well as the Fortune 500 company with five thousand 
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people at headquarters and dozens of offices around the world. EIC provides auto attendant, unified 
messaging, IVR, Email auto- response, presence management, conferencing, and much more. 

IC Server 

The Interaction Center (IC) is a client/server software product that transforms a Windows NT server into a 
comprehensive communications system. The IC server answers and processes calls. 

Handler 

Handlers are programs that the IC Server executes to respond to an event, such as an incoming call.   
Handlers are created using Interaction Designer, the visual programming tool included with Interaction 
Center.  A handler performs an action or actions in response to the occurrence of some event. A handler is 
simply a collection of steps that are organized and linked to form a logical flow of actions and decisions.   

Interaction Attendant 

The graphical tool for configuring and maintaining IC's auto attendant. 

Interaction Designer 

The IC graphical application development tool for creating, debugging, editing, and managing handlers 
and subroutines. 

IVR 

Interactive Voice Response (IVR) allows phone users to use their telephone keypad as a keyboard to input 
values in response to voice prompts played by a computer. 

Notifier 

The Notifier is an Interaction Center module that acts as a communication center for all other modules.  It 
listens for events generated by other modules and notifies other interested modules that the event has 
occurred. 

Queue 

Queues are containers for calls and other types of interactions that can be processed.  Each Interaction 
Client user has a user queue. Each workgroup, such as marketing or support, has a workgroup queue. 
Stand-alone phones not connected to PCs and fax machines have station queues. 

Queue Transfer 

Transfers a call directly to a user, workgroup, or station queue. 

StatWatcher 

StatWatcher is a subsystem of IC that contains information about all statistics in the IC system.   
StatWatcher is a generic "watcher" of statistic-related notification messages.  Interaction Supervisor plug-
ins receive statistical data from StatWatcher. 

Station Groups 

Station groups are groups of phones in break rooms, conference rooms, and other public areas. 

Station Queue 

A queue where interactions are placed when they are to be processed by a station. 

Supervisor Plug-In 

A Supervisor plug-In is a set of custom Supervisor View objects that are contained in a separate DLL.  For 
each view object type it contains, the Plug-In provides an interface to access the menu, toolbar, doc, 
view, help, and other information needed by Supervisor to host the Plug-In. 

Trunk 

A trunk is a communications line that connects two switching systems, such as the equipment in a 
telephone company's central office, and the PBX in a company. 

User Queue 

A queue where interactions (such as calls and chat sessions) intended for an individual user are routed.  



 

Interaction Supervisor User Guide Page 134 of 139 

View 

A view is a window that displays data.  Information can be displayed in columns, or rendered as a graph.  
Views can be positioned anywhere on the screen, or docked within Supervisor's workspace. 

Voice Mail Transfer 

Allows a caller to leave a voice mail for a specific queue. 

Workgroup 

In Interaction Center, a workgroup is a defined group of users related by function, department, project, or 
other organization. Workgroups can have extensions and queues, which enable all members of a 
workgroup to receive calls passed to the workgroup. An ACD Workgroup is a workgroup queue that 
receives ACD calls and chat sessions. 
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Change Log 
Interaction Supervisor documentation was updated for IC 2.4 as follows: 

1. Added a Tech Support Note to the topic titled "Exit Supervisor".  It explains how to remove the 
user's Supervisor configuration registry key, should the key become corrupted.  This problem is 
extremely rare, having occurred only once. 

2. Added a new IC Performance statistic named "Average Latency" to the System Monitoring Guide. 

3. Renamed some statistics in the documentation to better match labels displayed in Supervisor: 

 "Total CPU Utilization" is now "Total CPU Usage". 

 "System Host Tool Connection Errors" is now "Host Tool Connection Errors" 

 "System Host Tool Other Errors" is now "Host Tool Other Errors" 

 "Transaction Server Avg. Time per Successful Transaction" is now "Transaction Server 
Average Successful Transaction Time" 

 "Tracker Server Failed Transactions" is now "Failed Transactions" 

 "Tracker Server Posted Transactions" is now "Posted Transactions" 

 "Tracker Server Notifications" is now "Interaction Segment Notifications" 

 "Interaction Tracker Statistics" was renamed "Tracker Server Statistics" 

 "Transaction Server Executed Transactions" is now "Executed Transactions" 

 "Transaction Server Failed Transactions" is now "Failed Transactions" 

 "Maximum Speech Recognition Sessions" is now "Peak Number of Recognition Sessions" 

 "IP Connected to Database" is now "IP is Connected to Database" 

 "IP Server Connected to Database" is now "IP Server is Connected to Database" 

 "Admin Server Connected to Database" is now "Admin Server is Connected to Database" 

 "StatServer Connected to Database" is now "StatServer is Connected to Database" 

 "Admin Server PMQ is persisting to disk" is now "Admin Server's PMQ is persisting to disk" 

4. Added a new statistic category: "Transaction Server statistics". These statistics indicate the 
overall health of Transaction Server—a generic transaction server used for recording and logging. 

5. Help context strings for "Unlicensed Recordings (Today)" and "Unlicensed Recordings (Last 
Hour)" were swapped. That was corrected so that "What's This" help will open the correct user 
assistance. 

6. Added a new statistic category: IC Memory Usage.  These statistics report memory consumption 
for various IC Subsystems: 

Acc Server Acd Server 
Admin Server Alert Server 
Client Services Compression Manager 
Data Manager DS Server 
EMS Server FAX Server 
File Monitor Host Server 
IP IP Server 
IPDB Server Mail Account Monitor 
Notifier Out Of Proc 
Paging Server Post Office Server 
Reco Recorder Server 
Recorder Tran Server SMS Server 
Statistics Server Switchover 
Telephony Services Tracker Server 
Transaction Server VPIM Receiver 
Web Processor  

7. Added additional Switchover stats to the IC System Status statistics topic: 
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 Backup Ready - indicates the health of the backup (Switchover) server.  Displays Yes if the 
backup server is ready, or No if the backup server is known to be in a bad state. 

 Backup Server Name - provides the name of the backup server, if one is configured. 

 Time Since Last Switchover - indicates the amount of time since a switchover last occurred. 

 TS Ping Time - the amount of time in milliseconds to ping the IC's Telephony Services 
subsystem. 

 UDP Heartbeat Interval - Heartbeats are a series of signals emitted at regular intervals, by 
IC servers on the network. This stat indicates the transmission rate for UDP heartbeats on 
the Switchover server, expressed in milliseconds. 

8. Added a procedure titled "Allow Supervisor Message Creation" to the "Recommended Access 
Rights" topic.  This procedure explains how to grant the User right to send messages from 
Interaction Supervisor to Interaction Client users.   

9. In 2.4, Interaction Supervisor can send message to Interaction Client users (all versions except 
the Win32 version). Administrators may choose to send a one-time informational message, or to 
use an alert to send messages automatically based on any real time statistic that Interaction 
Supervisor can monitor.  To become acquainted with this feature, read "Send Messages to 
Interaction Client users". It provides an overview of features that allow a Supervisor user to 
compose and send messages. 

10. Updated coverage of the Alert Properties dialog, which now offers the means to send a 
Supervisor Message in response to an Alert. 

11. Added a new statistic, Number of available remote licenses, to the IC System Statistics. 

12. Added new Interaction Recorder Error statistics: 

Destination Device Full Errors Destination Directory Non-Existent 
Destination Directory Non-Writeable Errors Number of Call Generation Errors 
Number of Chat Generation Errors Number of Email Generation Errors 
Number of Fax Generation Errors Source Directory Non-Existent Errors 
Source Directory Permission Errors Source File Delete Errors 
Source File Non-Existent Errors Source File Permission Errors 

13. Added new Host Tools Error statistics: 

Ave. Host Connection Time Ave. Successful Connects 
Ave. Time for Successful Disconnects Ave. Successful Screen Transitions 
Ave. Time for Successful Screen Validations Ave. Successful Wait for Ready-To-Sends 
Ave. Time for Successful Wait-for-Cursors Ave. Successful Wait-for-Strings 
Host Connection Time Host Tool Transition Time 
Host Tools Connection Time Host Tools Disconnect Time 
Host Tools Validation Time Number of Failed Connects 
Number of Failed Disconnects Number of Failed Screen Transitions 
Number of Failed Screen Validations Number of Failed Wait for Ready-To-Sends 
Number of Failed Wait-for-Cursors Number of Failed Wait-or-Strings 
Number of Successful Connects Number of Successful Disconnects 
Number of Successful Screen Transitions Number of Successful Screen Validations 
Number of Successful Wait for Ready-To-Sends Number of Successful Wait-for-Cursors 
Number of Successful Wait-for-Strings Wait for Ready To Send Time 
Wait-for-Cursor Time Wait-for-Strings Time  

14. Added a help topic for the Change Station dialog.  It allows users to change stations without 
restarting Supervisor. 

15. The Lines view was renamed Call Activity view.  Instead of just showing line activity, the view 
now has a drop down to show either line or station activity.   

16. Updated the Using Queue Monitor Controls topic to describe the new Coach feature.  This feature 
adds the Supervisor to an Agent's interaction in a mode that allows the Supervisor to speak to 
the Agent without being overheard by the customer.  Also added Coach an Interaction topic. 

17. Added these additional Recording Statistics to the System Monitoring Guide: 

 IR Screen Recordings in Progress—The number of active screen recordings. 

 Successful Screen Recordings (Today)—The number of successfully processed screen 
recordings since midnight of the current day, local to the IC/IR Server. 
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 Successful Screen Recordings (Last Hour)—The number of successfully processed screen 
recordings in the last hour. This number is accurate to a 1 minute granularity. 

 Unsuccessful Screen Recordings (Today)—The number of unsuccessfully processed screen 
recordings since midnight of the current day, local to the IC/IR Server. 

 Unsuccessful Screen Recordings (Last Hour)—The number of unsuccessfully processed 
screen recordings in the last hour. This number is accurate to a 1 minute granularity. 
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Manage Alerts dialog, 73, 116 

manage all alerts in one place, 73 
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shortcut, 24 
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editing alert ranges for, 92 

Support, 27 
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Transaction Server, 135 

tray icon, 131 

U 

user name, 113 

V 
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